
KINCO HMI WARE 2.0
Kinco típusú univerzális kijelzők programozói környezete

magyar nyelvű használati utasítás

ver1.0

1.



Tartalomjegyzék
B  evezető  ........................................................................................................................7
E  gyszerű projekt létrehozása  .........................................................................................8
K  apcsoló elem hozzáadása a programhoz  ...................................................................10
A   HMIware program használata  ..................................................................................13
F  első menüsor elemei  ..................................................................................................15

FILE menü......................................................................................................................................15
EDIT menü......................................................................................................................................16
Alap eszköztár.................................................................................................................................19
Könyvtár-eszközök eszköztár.........................................................................................................20
Vonalstílus eszköztárak...................................................................................................................20
Pozicionáló eszköztár.....................................................................................................................21
Rajz eszköztár.................................................................................................................................22
Képernyő eszköztár.........................................................................................................................22
Állapot eszköztár............................................................................................................................22
Letöltés, fordítás eszközök.............................................................................................................23
Elem pozíció eszköztár...................................................................................................................23

B  it State Setting  ...........................................................................................................24
Bit State Setting → Bit State Setting..............................................................................................25
Bit State Setting → Tag .................................................................................................................27
Bit State Setting → Graphics .........................................................................................................28
Bit State Setting → Control Setting ...............................................................................................29
Bit State Setting → Display Setting ..............................................................................................30

B  it State Lamp  .............................................................................................................31
Bit State Lamp → Bit State Lamp .................................................................................................32
Bit State Lamp → Tag ...................................................................................................................33
Bit State Lamp →  Graphics ..........................................................................................................34
Bit State Lamp → Control Setting .................................................................................................35
Bit State Lamp → Display Setting ................................................................................................36

B  it State Switch  ...........................................................................................................37
Bit State Switch → Bit State Switch .............................................................................................38
Bit State Switch → Tag ..................................................................................................................39
Bit State Switch → Graphics .........................................................................................................40
Bit State Switch → Control Setting ...............................................................................................41
Bit State Switch → Display Setting ...............................................................................................42

D  irect Window  .............................................................................................................43
Direct Window → Direct Window ................................................................................................44
Direct Window → Display Setting ................................................................................................45

M  ultiple State Setting  ..................................................................................................46
Multiple State Setting → Multi-State Setting ................................................................................47
Multiple State Setting → Tag .........................................................................................................49
Multiple State Setting → Graphics ................................................................................................50
Multiple State Setting → Control Setting ......................................................................................51
Multiple State Setting → Display Setting ......................................................................................52

M  ultiple State Display  .................................................................................................53
Multiple State Display → Multi-Sate Display ...............................................................................54
Multiple State Display → Tag .......................................................................................................55
Multiple State Display → Graphics ...............................................................................................56

2.



Multiple State Display → Control Setting .....................................................................................57
Multiple State Display → Display Setting ....................................................................................58

M  ultiple State Switch  ..................................................................................................59
Multiple State Switch → Multi-State Switch ................................................................................60
Multiple State Switch → Tag .........................................................................................................61
Multiple State Switch → Graphics ................................................................................................62
Multiple State Switch → Control Setting ......................................................................................63
Multiple State Switch → Display Setting ......................................................................................64

S  croll Bar  .....................................................................................................................65
Scroll Bar → Scroll Bar .................................................................................................................66
Scroll Bar → Scroll Bar Extended Attributes.................................................................................67
Scroll Bar → Graphics ...................................................................................................................68
Scroll Bar → Control Setting .........................................................................................................69
Scroll Bar → Display Setting ........................................................................................................70

M  oving Component  .....................................................................................................71
Moving Component → Basic Attributes .......................................................................................72
Moving Component → Moving Component .................................................................................73
Moving Component → Mozgások típusai:.....................................................................................74
Moving Component → Tag ...........................................................................................................75
Moving Component → Graphics ...................................................................................................76
Moving Component → Control Setting .........................................................................................77
Moving Component → Display Setting ........................................................................................78

A  nimation  ....................................................................................................................79
Animation → Animation ...............................................................................................................80
Animation →  Tag .........................................................................................................................81
Animation → Graphics ..................................................................................................................82
Animation →  Control Setting .......................................................................................................83
Animation → Display Setting ........................................................................................................84

A  larm Display  ..............................................................................................................85
Alarm Display → Alarm Display ..................................................................................................86
Alarm Display → Display Setting .................................................................................................87

T  rend Curve  .................................................................................................................88
Trend Curve → Trend Graphics .....................................................................................................89
Trend Curve → Channel ................................................................................................................90
Trend Curve → Extended Attributes .............................................................................................91
Trend Curve → Scale .....................................................................................................................92
Trend Curve → Save Historical Data ............................................................................................93
Trend Curve → Print.......................................................................................................................94
Trend Curve → Display Setting .....................................................................................................95

X  Y Plot  ........................................................................................................................96
XY Plot → XY Curve Graphics .....................................................................................................97
XY Plot → Channel........................................................................................................................98
XY Plot → Extended Attributes .....................................................................................................99
XY Plot → Save Historycal Data ................................................................................................100
XY Plot → Display Setting ..........................................................................................................101

B  ar Picture  .................................................................................................................102
Bar Picture → Bar ........................................................................................................................103
Bar Picture → Scale .....................................................................................................................104
Bar Picture → Graphics ...............................................................................................................105

3.



Bar Picture → Display Setting .....................................................................................................106
M  eter  ..........................................................................................................................107

Meter → Meter Component .........................................................................................................108
Meter → Meter Component Extended Attribute .........................................................................109
Meter → Graphics ........................................................................................................................110
Meter → Display Setting .............................................................................................................111

R  ecipe Data  ................................................................................................................112
Recipe Data → Recipe Data ........................................................................................................113
Recipe Data → Tag ......................................................................................................................114
Recipe Data → Graphics ..............................................................................................................115
Recipe Data → Control Setting ...................................................................................................116
Recipe Data → Display Setting ...................................................................................................117

E  vent Display  .............................................................................................................118
E  vent Display → Event Information   ........................................................................119

Event Display → Display Setting ................................................................................................120
I  ndirect Window  ........................................................................................................121
I  ndirect Window → Indirect Window   ......................................................................122

Indirect Window → Display Setting ............................................................................................123
N  umber Display  .........................................................................................................124

Number Display → Numeric Data ..............................................................................................125
Number Display → Graphics ......................................................................................................126
Number Display → Control Setting ............................................................................................127
Number Display → Display Setting ............................................................................................128

N  umber Input  .............................................................................................................129
Number Input → Numeric Data ..................................................................................................130
Number Input → Keyboard Setting .............................................................................................131
Number Input → Graphics ..........................................................................................................132
Number Input → Control Setting ................................................................................................133
Number Input → Display Setting ................................................................................................134

T  ext Display  ...............................................................................................................135
Text Display → Graphics .............................................................................................................136
Text Display → Display Setting ..................................................................................................137

T  ext Input  ...................................................................................................................138
Text Input → Graphics .................................................................................................................139
Text Input → Display Setting ......................................................................................................140

O  scillograph  ...............................................................................................................141
Oscillograph → Scope Chart .......................................................................................................142
Oscillograph → Channel..............................................................................................................143
Oscillograph → Extended Attributes ...........................................................................................144
Oscillograph → Display Setting ..................................................................................................145

N  ote Book  ..................................................................................................................146
Note Book → Notepad ................................................................................................................147
Note Book → Keyboard Setting ..................................................................................................148
Note Book → Graphics ................................................................................................................149
Note Book → Control Setting .....................................................................................................150
Note Book → Display Setting .....................................................................................................151

M  ultiple State Neon Lamp  ........................................................................................152
Multiple State Neon Lamp → Neon Lamp ..................................................................................153

4.



Multiple State Neon Lamp → Tag ...............................................................................................154
Multiple State Neon Lamp → Graphics ......................................................................................155
Multiple State Neon Lamp → Display Setting ............................................................................156

B  it State Neon Lamp  .................................................................................................157
Bit State Neon Lamp → Bit Neon Lamp .....................................................................................158
Bit State Neon Lamp → Tag ........................................................................................................159
Bit State Neon Lamp → Graphics ...............................................................................................160
Bit State Neon Lamp → Display Setting .....................................................................................161

G  rid  ............................................................................................................................162
Grid → Table ...............................................................................................................................163
Grid → Control Setting ................................................................................................................164
Grid → Display Setting ...............................................................................................................165

H  istorical Data Display  .............................................................................................166
Historical Data Display → Display Properties ............................................................................167
Historical Data Display → Background Attribute .......................................................................168
Historical Data Display → Channel Properties ...........................................................................169
Historical Data Display → Save Historical Data .........................................................................170
Historical Data Display → Background Print .............................................................................171
Historical Data Display → Title Bar Properties...........................................................................172
Historical Data Display → Display Setting .................................................................................173

O  peration Log  ............................................................................................................174
Operation Log → Table Display Component ..............................................................................175
Operation Log → Display Setting ...............................................................................................177

C  amera  .......................................................................................................................178
Camera → Display Setting ..........................................................................................................179

S  cale  ...........................................................................................................................180
Scale → Display Setting ..............................................................................................................181

F  unction Key  .............................................................................................................182
Function Key → Tag ....................................................................................................................184
Function Key → Graphics ...........................................................................................................185
Function Key → Control Setting .................................................................................................186
Function Key → Display Setting .................................................................................................187

A  larm Bar  ..................................................................................................................188
Alarm Bar → Display Setting ......................................................................................................189

T  imer  ..........................................................................................................................190
Timer → Timer function...............................................................................................................191
Timer →  Display Setting ............................................................................................................192

B  itmap  .......................................................................................................................193
Bitmap → Display Setting ...........................................................................................................194

V  ector Graph  ..............................................................................................................195
Vector Graph → Display Setting .................................................................................................196

N  ote Pad  ....................................................................................................................197
Note Pad → Display Setting ........................................................................................................198

F  ile List  ......................................................................................................................199
File List → Graphics ....................................................................................................................200
File List → Display Setting .........................................................................................................201

D  ata transmission  ......................................................................................................202
Data transmission → Trigger Address .........................................................................................203

5.



Data transmission → Tag .............................................................................................................204
Data transmission → Graphics ....................................................................................................205
Data transmission → Control Setting ..........................................................................................206
Data transmission → Display Setting ..........................................................................................207

D  ate/Time  ..................................................................................................................208
Date/Time → Graphics ................................................................................................................209
Date/Time → Display Setting ......................................................................................................210

D  ynamic Graph  ..........................................................................................................211
Dynamic Graph → Dynamic Graph Position...............................................................................212
Dynamic Graph → Display Setting .............................................................................................213

U  ser Info Display  .......................................................................................................214
User Info Display → Display Setting ..........................................................................................215

C  ombination Operations  ............................................................................................216
Combination Operations → Display Setting ...............................................................................218

P  ipeline  ......................................................................................................................219
Pipleline → Pipe Info...................................................................................................................221
Pipleline → Display Setting ........................................................................................................222

6.



Bevezető
Az univerzális kijelző, vagyis HMI, kétirányú kommunikációt tesz lehetővé a kezelő és az irányított 
berendezés vagy folyamat között. A képernyőn megjelenő tartalom, valamint az eszközökkel 
történő kommunikáció paraméterezése a díjmentes HMIware programban végezhető el

Az MT5000 és MT4000 sorozat jellemzői

• RISC központi egység, nagy működési sebességgel és alacsony fogyasztással

• Beágyazott operációs rendszer

• Széles megjeleníthető színtartomány, éles kép

• Az MT5000 sorozat minden egyes tagja nagy sebességű Ethernet és USB interfésszel 
rendelkezik, MT4000 esetén pedig a program letöltéshez USB interfész áll rendelkezésre.

• 65536 szín

• Egyidejű kommunikáció több soros porton keresztül. Minden eszközön legalább két soros 
vonal megtalálható, melyek akár különböző protokollon keresztül is képesek kommunikálni.

• Különböző képformátumok támogatása, mint 24 bites bitkép, JPEG és GIF

• C nyelven készített makrók támogatása, különböző futtatási módokkal

• Időzítő funkciók

• Gyors programletöltés USB kapcsolaton keresztül

• A fényerő és a kontraszt, belső változókon keresztül, alkalmazásból is állítható

• Szabadon módosítható induló logó

• A Windowsban elérhető teljes karakterkészlet használható

• Számos PLC kommunikáció támogatása
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Egyszerű projekt létrehozása
Indítsa el a Kinco HMIware programot, ezt követően a következő képernyő jelenik meg. 

A felső menüsorban válassza a FILE menüpont NEW elemét, vagy kattintson az eszköztár NEW 
PROJECT elemére. A megjelenő ablakban a PROJECT NAME mezőben meg kell adni a projekt 
nevét, a PROJECT PATH pedig az elérési utat tartalmazza. Amennyiben az elérési utat meg szeretné 
változtatni, kattintson az elemre és adja meg az új elérési utat. 

Az  OK gombra  kattintva  a  program elkészíti  az  üres  projektet.  Első 
lépésben meg kell határozni az alkalmazandó kijelző típusát. A képernyő 
bal oldalán található GRAPH ELEMENT WINDOW területén, a HMI 
részt kiválasztva teheti ezt meg. A listában válassza ki a megfelelő típust, 
majd az egér bal gombját folyamatosan lenyomva tartva húzza a szürke 
szerkesztési  területre.  Ezt  követően  a  megjelenő  ablakban  meg  kell 
határozni a tájolási módot, mely lehet vízszintes (HORIZONTAL) vagy 
függőleges  (VERTICAL)
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Ezt követően a szerkesztési területen megjelenik a kijelző sematikus rajza. 

Következő lépésként a kijelzőhöz kapcsolódó eszköz vagy eszközöket kell elhelyezni a tervező 
felületen, melyek a  GRAPH ELEMENT WINDOW → PLC részén találhatók meg. 

A listában válassza ki a megfelelő típust, majd az egér bal gombját folyamatosan lenyomva tartva 
húzza a szürke szerkesztési területre azt. A kommunikációs port valamint az alkalmazandó átviteli 
közeg  (soros,  Ethernet)  meghatározása  az  elemek  összekötésével  lehetséges.  A  megfelelő 
csatlakozók a GRAPH ELEMENT WINDOW → CONNECTOR részén találhatók. A megfelelő 
csatlakozó elhelyezését  követően az összekötő vezetéket  a  kijelzőhöz és  a csatlakoztatni  kívánt 
eszközhöz (PLC-hez) is csatlakoztatni kell, ahogy ez az alábbi ábrán is látható. 

Az  így  elkészített  alkalmazás  már  kipróbálható.  Első  lépésként  le  kell  fordítani  az  elkészített 
projektet,  mely a  felső  menü  TOOLS → COMPILE elemére  kattintva  végezhető  el.  A sikeres 
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fordítást követően a program kipróbálható valós eszköz nélkül is, ehhez a TOOLS → OFFLINE 
SIMULATION menüpontot kell kiválasztani. Majd a megjelenő ablakban a SIMULATE gombra 
kattintva elindul a program szimulációja, és a következő képernyő jelenik meg: 

Mivel az elkészített projektben nincsen semmilyen képernyő tartalom, üres fekete képernyő jelenik 
meg. A szimulációs képernyőn jobb egérkattintással a CLOSE paranccsal bezárható a szimuláció. 

Kapcsoló elem hozzáadása a programhoz
A szerkesztési területen a kijelzőre jobb egérgombbal kattintva válassza  az EDIT menüpontot a 
képernyőtartalom szerkesztéséhez. 

Ezt követően a program képernyő szerkesztő módba vált, ahol elkészíthetők a kívánt képernyő 
tartalmak. 
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A bal oldalt található GRAPH ELEMENT WINDOW → PLC PARTS részénél válassza 
ki a BIT STATE SWITCH elemet, majd az egér bal gombját folyamatosan lenyomva 
tartva húzza a szerkesztési területre azt. 

A megjelenő ablak BASIC ATTRIBUTE fülén nem szükséges változtatni, ebben az esetben az LB0 
regisztert fogja a kijelző állítani. A BIT STATE SWITCH fület kiválasztva a SWITCH TYPE 
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legyen TOGGLE, melynek eredménye az lesz, hogy a bites változó mindig az ellentettjére vált, ha 0 
volt 1 lesz, ha 1 volt 0 lesz. 

Az OK gombot lenyomva elhelyezhető a szerkesztési területen a kapcsoló. A projekt újrafordítása a 
TOOLS → COMPILE elemére kattintva végezhető el. A sikeres fordítást követően a program 
kipróbálható valós eszköz nélkül is, ehhez a TOOLS → OFFLINE SIMULATION menüpontot kell 
kiválasztani, majd a megjelenő ablakban a SIMULATE gombra kattintva elindul a program. 
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A megjelenő kijelzőn most már kipróbálható a kapcsoló működése szimulációs módban is. 

A HMIware program használata

A program elindítását követően, egy új projekt hozható létre az előző fejezetben leírt módon. A 
képernyőn a következő elemek találhatók meg. 
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a.) címsor
b.) menüsor c.) alap eszköztár d.) rajz eszköztár

p.) üzenet ablak
r.) státusz sor

i.) képernyő választó

n.) projekt struktúra

o.) projekt fájlok

s.) képernyő szerkesztő

m.) grafikus elemek

e.) könyvtár eszközök

f.) pozicionáló eszközök

j.) kitöltő eszközök

g.) rendszer eszköztár



A különböző elemek megjelenése ki- illetve bekapcsolható a menüsor VIEW – TOOLBAR 
menüpontban. 
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Felső menüsor elemei

FILE menü

NEW: Új projekt létrehozása, válassza a FILE menü NEW elemét vagy kattintson az 
eszköztár megfelelő elemét.

OPEN: meglévő projekt megnyitásához válassza a FILE menü OPEN elemét, vagy 
kattintson az eszköztár megfelelő elemére. 

A megnyíló ablakban jelölje ki a megnyitni kívánt állományt (*.wpj) és kattintson az OPEN 
gombra. 

SAVE/ SAVE AS: módosítások mentése / mentés másként. Mentés másként esetén a 
projekt új névvel került elmentésre. 
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CLOSE: megnyitott projekt bezárása a FILE CLOSE elemével lehetséges. 
Amennyiben a megnyitott projekt nincs elmentve, a program rákérdez, hogy 
mentse-e a módosításokat. 

Az előzőleg megnyitott projektek közül a program eltárolja a három legtöbbet megnyitott projektet. 
Az elemre kattintva egyszerűen megnyitható a kiválasztott állomány. 

EDIT menü

UNDO: visszavonás, előző művelet visszavonása. 

REDO: visszavonás törlése, előzőleg kiadott UNDO művelet visszavonása. 

A program az utolsó művelet visszavonását, illetve annak törlését támogatja. 
A visszavonás és a visszavonás törlés funkciók a következő elemekre alkalmazhatóak. 

• Elem elhelyezése a szerkesztő felületen
• Statikus elem rajzolása
• Objektum mozgatása, áthelyezése
• Objektum méretének megváltoztatása
• Pozíció eszköztárról kiadott műveletek
• Vonal vastagság, vonal stílus, nyilak
• Objektumok kitöltési stílusa
• Objektumok keretének színe
• Objektumok kitöltési színe
• Réteg váltások
• Csoportosítás, csoportosítás feloldása
• Vágólap műveletek, másolás, beillesztés, törlés
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• Csoportos másolás

Vágólap műveletek: CUT, COPY, PASTE, DELTE: kivágás, másolás, 
beillesztés, törlés. 
 

NUDGE – LEFT, RIGHT, UP, DOWN: kiválasztott elem mozgatása jobbra, 
balra le vagy fel egy pixellel. Az elemek mozgatása a kurzorbillentyűkkel is 
lehetséges. 

ALIGN – LEFT, RIGHT, TOP, BOTTOM, VERTICAL MIDLINE, 
HORIZONTAL MIDLINE: elemek igazítása, legalább két elemet kell hozzá 
kiválasztani. 

Példa elemek igazítására: 

1.) Elemek elhelyezve a szerkesztő képernyőn. 2.) ALIGN – RIGHT: elemek rendezése, hogy a 
jobb szélük egybe essen. 

SIZE – WIDTH, HEIGHT, BOTH: elemek méretezése, legalább két elemet 
kell kiválasztani. Megadható, hogy a kiválasztott elemek azonos 
szélességüek (WIDTH), magassságúak (HEIGHT) legyenek. BOTH 
választás esetén a magasság és a szélesség is azonos lesz. 

Példa elemek mérezetésére

1.) Elemek elhelyezve a szerkesztő képernyőn. 2.) SIZE – BOTH: elemek közös méretezése, 
azonos szélesség, hosszúság
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LAYER – SET TOP, SET BOTTOM, PREVIOUS, NEXT LAYER
Rétegek kezelése, használható ha egy vagy több elem fedi egymást. A 
kiválasztott elem előre vagy előbbre hozását, illetve hátra vagy hátrébb 
hozását teszi lehetővé. 

Példa a rétegek kezelésére:

A fenti ábrán a háttérben levő szürke négyzet a kijelölést követően a LAYER – SET TOP LAYER 
paranccsal a többi elem elé került. 

GROUP/UNGROUP: több kijelölt elem csoportba foglalása, illetve csoport 
megszüntetése. Az csoportba sorolt elemek egy elemként kezelhetők. 

EQUAL HORIZONZAL/VERTICAL SPACE: több kijelölt elem esetén az elemek 
közötti egyenlő távolság beállítására használható, függőleges és vízszintes irányban. 

HORIZONZAL/VERTICAL CENTER: több kijelölt elem esetén alkalmazható, az 
elemeket függőleges illetve vízszintes közös ponthoz rendezi. 

FLIP HORIZONTALLY/ VERTICALLY, ROTATE: Csak a szerkesztővel rajzolt 
alakzatok esetén használható. A kiválasztott elem tükrözhető a függőleges vagy 
vízszintes tengelyére, illetve 90°-al elforgatható. 

SHOW GRID: a szerkesztőképernyőn a pozicionálást elősegítő pontháló 
megjelenésének be és kikapcsolása. 

ALIGNMENT GRID: elemek automatikus igazítása a szerkesztőképernyőn 
megjeleníthető ponthálóhoz
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Alap eszköztár

Csoportos másolás

Egy kiválasztott elem vagy elemek többszörös másolását teszi lehetővé, mely esetén a következő 
beállítások adhatók meg. 

• COPY TYPE

◦ PITCH: másolás kezdete a komponens bal felső sarka

◦ INTERVAL: másolás kezdete a komponens jobb oldala

• COPY QUANTITY pontban megadható, hogy a kiválasztott elemből a program hányat 
helyezzen el a program X, illetve Y irányban. 

• ADRESS AUTO CHANGE, automatikus címváltoztatás bekapcsolását követően 
megadható, hogy a komponens által hivatkozott cím növekedjen vagy csökkenjen X vagy Y 
irányban. 
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Új projekt
Projekt megnyitása

Mentés

Kivágás

Beillesztés

Csoportos másolás

Kivágás

Törlés

Visszavonás törlése

Visszavonás
Keresés

Nyomtatási kép

Nyomtatás

Kiválasztott elem 
tulajdonságai

Elemek nevének 
megjelenítése

Program 
információk



Könyvtár-eszközök eszköztár

Vonalstílus eszköztárak

A különböző vonalstílusok a szerkesztővel készített elemekre (vonal, négyzet, kör stb.) 
alkalmazhatók. 
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Szöveges könyvtár

Változók címei

Riasztási események

Eseménykezelő

PLC események kezelése

Új grafika létrehozása Grafikus fájl importálása

Hangok könyvtár

Új makró hozzáadása

Recept adatfájl importálás

Induló képernyő 
szerkesztése

Folyamatos vonal

Szaggatott vonal

Pontvonal

Szaggatott és pontvonal

Szaggatott és kettős pontvonal 1. nyíl stílus

2. nyíl stílus

3. nyíl stílus

4. nyíl stílus

5. nyíl stílus

6. nyíl stílus

Vonalvastagságok



Pozicionáló eszköztár

21.

Mozgatás 1 pixelt balra

Mozgatás 1 pixelt jobbra

Mozgatás 1 pixelt fel

Mozgatás 1 pixelt le

Balra igazítás

Jobbra igazítás

Felülre igazítás

Alulra igazítás

Vízszintes középvonalhoz 
rendezés

Függőleges középvonalhoz 
rendezés

Azonos szélesség

Azonos magasság

Azonos magasság és 
szélesség

Előre hozás

Hátra küldés

Előző réteg

Következő réteg

Csoportosítás

Csoportosítás 
megszüntetése

Azonos vízszintes 
távolság

Azonos függőleges 
távolság

Középre igazítás 
vízszintesen

Középre igazítás 
függőlegesen

Tükrözés függőleges tenglyre

Tükrözés vízszintes tenglyre

Forgatás 90°-al

Kijelölt elem pozíciójának 
rögzítése



Rajz eszköztár

Képernyő eszköztár

Állapot eszköztár

22.

Kiválasztás

Vonal rajzolása

Görbe rajzolása

Téglalap rajzolása

Téglalap rajzolása

Vonallánc rajzolása

Sokszög rajzolása

Ellipszis rajzolása

Körcikk rajzolása

Szöveg elhelyezése
Kép betöltése

Objektum színe

Objektum kitöltési színe

Szerkesztő rács be/ki

Átlátszóság színe

Színes / fekete fehér

Rácsponthoz 
illesztés

Új képernyő 
hozzáadása

Képernyő törlése

Képernyő 
tulajdonságok

Lapozás vissza

Aktuális oldal

Lapozás előre

Nagyítás

Kicsinyítés

1:1 arányú méret

Aktuális állapot 
kiválasztása

Nyelv 
kiválasztása

Aktuális állapot 
kiválasztása



Letöltés, fordítás eszközök

Elem pozíció eszköztár

23.

Progojekt 
fordítása

Összes projekt 
fordítása

Fordítás 
eredményének 
törlése

Letöltés

Letöltés 
beállítása

Indirekt online 
szimuláció

Offline 
szimuláció

Direkt 
szimuláció

Elem 
tartalmának 
balra igazítása

Elem 
tartalmának 
jobbra igazítása

Elem 
tartalmának 
felfele igazítása

Elem 
tartalmának 
lefele igazítása

Elem 
tartalmának 
vízszintes 
középre 
igazítása

Elem 
tartalmának 
függőleges 
középre 
igazítása



Bit State Setting

A „Bit State Setting” elemmel egy olyan területet definiálhatunk, amellyel bitműveleteket 
végezhetünk egy megadott biten. Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára 
kattintunk és behúzzuk a kijelző területére. Dupla kattintással elérjük az elem beállításait.
Az első ablakban a „Write Address” területen állíthatjuk be, hogy melyik bitünket szeretnénk 
vezérelni. A „HMI” és „PLC No.” megegyezik azzal, ahova az elemet elhelyeztük.

• Addr. Type: A kontrollálni kívánt regiszter típusa.
• Address: A regiszter címe.
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn). 
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Bit State Setting → Bit State Setting

Itt választhatjuk ki a gombunk funkcióját.
A következő táblázatban ezen funkciók magyarázatát látjuk.

25.



On Amikor megérintjük a felületet a bit aktív (ON) állapotba kerül, majd miután 
elengedjük, ezt az állapotot tartja meg.

Off Amikor megérintjük a felületet a bit inaktív (OFF) állapotba kerül, majd miután 
elengedjük, ezt az állapotot tartja meg.

Toggle Amikor megérintjük a gombot a bit állapota az ellenkező állapotba kerül. 
(OFF>>ON, ON>>OFF)

Reset Amikor megérintjük a gombot a regiszterünk ON állapotba kerül, majd miután 
elengedjük OFF állapotba áll.

Set ON at 
window open

Amikor ezt az elemet tartalmazó ablak felnyílik a beállított bit ON állapotba 
kerül.

Set OFF at 
window open

Amikor ezt az elemet tartalmazó ablak felnyílik a beállított bit OFF állapotba 
kerül.

Set ON at 
window close

Amikor ezt az elemet tartalmazó ablakot bezárjuk a beállított bit ON állapotba 
kerül. Ezt a műveletet csak a helyi biteknél alkalmazhatjuk! (LB vagy LW.x)

Set Off at 
window  close

Amikor ezt az elemet tartalmazó ablakot bezárjuk a beállított bit OFF állapotba 
kerül. Ezt a műveletet csak a helyi biteknél alkalmazhatjuk! (LB vagy LW.x)

Set ON at 
window Max.

Amikor ezt az elemet tartalmazó ablakot felnagyítjuk a beállított bit ON állapotba 
kerül.

Set OFF at 
window Max.

Amikor ezt az elemet tartalmazó ablakot felnagyítjuk a beállított bit OFF 
állapotba kerül.

Set ON at 
window Min.

Amikor ezt az elemet tartalmazó ablakot lekicsinyítjük a beállított bit ON 
állapotba kerül.

Set OFF at 
window Max.

Amikor ezt az elemet tartalmazó ablakot lekicsinyítjük a beállított bit OFF 
állapotba kerül.

Set ON while 
back light OFF

Amikor ezt az elemet tartalmazó ablak aktív és a világítása kikapcsol a beállított 
bit ON állapotba kerül.

Set OFF while 
back light OFF

Amikor ezt az elemet tartalmazó ablak aktív és a világítása kikapcsol a beállított 
bit OFF állapotba kerül.

Set ON at 
successful input

Amikor a számbevitelt befejeztük azon az ablakon ahol ezt az elemet elhelyeztük 
a beállított bit ON állapotba kerül.

Set OFF at 
successful input

Amikor a számbevitelt befejeztük azon az ablakon ahol ezt az elemet elhelyeztük 
a beállított bit OFF állapotba kerül.
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Bit State Setting → Tag 

Ebben a menüben állíthatjuk be az aktuális elem feliratait.
A „Use Tag” jelölőnégyzetét kipipálva beállíthatjuk a különböző állapotokban megjelenítendő 
feliratokat, azok méretét, színét, stílusát.
Ha különböző nyelveket szeretnénk használni, akkor azt is beállíthatjuk, ha már elkészítettük a 
„Text Library” menüben a szükséges feliratokat.
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Bit State Setting → Graphics 

Itt választhatjuk ki, hogy a gombunk milyen külalakkal rendelkezzen.
Az „Import Graphics” gombra kattintva válogathatunk a program által felkínált különböző stílusú 
gombok közül. Lehetőségünk van egyedi gombok készítésére is az eszköztárban a „New Graphic” 
ikonra kattintva. 
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Bit State Setting → Control Setting 

Itt beállíthatjuk, hogy az elemünk milyen feltételek mellett legyenek működtethető illetve, milyen 
feltételek mellett módosíthassuk ezt az elemet.

• Always Valid: Mindig módosítható az elem.
• Always Invalid: Sose legyen módosítható az elem. (Itt egy almenübe beállíthatjuk, hogy a 

nem használható elem látható legyen-e.)
• Conditional Enabling: Beállíthatjuk, hogy milyen biztonsági szinten lehessen módosítani 

az elemet, illetve egy másik regiszter tartalmától is függővé tehetjük az elem módosítását.
• Security Level: Biztonsági szint
• Permission Control: Hozzáférés vezérlés
• Register Control: Regiszter vezérelt hozzáférés
• Bit Control: Bit állapotától függő hozzáférés
• Word Control: Word típusú regiszter tartalmától függő hozzáférés
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Bit State Setting → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Bit State Lamp

A „Bit State Lamp” elemmel tudjuk kijelezni a PLC bitjeinek állapotát.

Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző 
területére. Dupla kattintással elérjük az elem beállításait.

A „Read Address” mezőben kiválaszthatjuk, hogy milyen címet olvasson az elemünk.

• Addr. Type: Az olvasni kívánt regiszter típusa.
• Address: A regiszter címe.
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn). 
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Bit State Lamp → Bit State Lamp 

Beállíthatjuk, hogy a kijelzőn hogyan jelenjen meg a bit állapota.
• Normal: A bit normál állapotát jeleníti meg.
• Value 1 Blinking on state 0, value 0 Showing state 0: Ha a bit értéke 1 villog a 0 

állapotban, ha a bit értéke 0 a 0 állapotot mutatja.
• Value 1 Blinking on state 1, value 0 Showing state 0: Ha a bit értéke 1 villog a 1 

állapotban, ha a bit értéke 0 a 0 állapotot mutatja.
• Value 1 switch Blinking on state 0 or 1, value 0 Showing state 0: Ha a bit értéke 1 villog 

0 és 1 érték között, ha a bit értéke 0 a 0 állapotot mutatja.
• Value 0 Blinking on state 0, value 1 Showing state 0: Ha a bit értéke 0 villog a 0 

állapotban, ha a bit értéke 1 a 0 állapotot mutatja.
• Value 0 Blinking on state 1, value 1 Showing state 0: Ha a bit értéke 0 villog a 1 

állapotban, ha a bit értéke 1 a 0 állapotot mutatja.
• Value 0 switch Blinking on state 0 or 1, value 1 Showing state 0: Ha a bit értéke 0 villog 

0 és 1 érték között, ha a bit értéke 1 a 0 állapotot mutatja.
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Bit State Lamp → Tag 

Ebben a menüben állíthatjuk be az aktuális elem feliratait.
A „Use Tag” jelölőnégyzetét kipipálva beállíthatjuk a különböző állapotokban megjelenítendő 
feliratokat, azok méretét, színét, stílusát.
Ha különböző nyelveket szeretnénk használni, akkor azt is beállíthatjuk, ha már elkészítettük a 
„Text Library” menüben a szükséges feliratokat.
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Bit State Lamp →  Graphics 

Itt kiválaszthatjuk, hogy a gombunk milyen külalakkal rendelkezzen.
Az „Import Graphics” gombra kattintva válogathatunk a program által felkínált különböző stílusú 
gombok közül. Lehetőségünk van egyedi gombok készítésére is az eszköztárban a „New Graphic” 
ikonra kattintva. 
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Bit State Lamp → Control Setting 

Itt beállíthatjuk, hogy az elemünk milyen feltételek mellett legyenek müködtethető, illetve milyen 
feltételek mellett módosíthassuk ezt az elemet.

• Always Valid: Mindig módosítható az elem.
• Always Invalid: Sose legyen módosítható az elem. (Itt egy almenübe beállíthatjuk, hogy a 

nem használható elem látható legyen-e.)
• Conditional Enabling: Beállíthatjuk, hogy milyen biztonsági szinten lehessen módosítani 

az elemet, illetve egy másik regiszter tartalmától is függővé tehetjük az elem módosítását.
• Security Level: Biztonsági szint
• Permission Control: Hozzáférés vezérlés
• Register Control: Regiszter vezérelt hozzáférés
• Bit Control: Bit állapotától függő hozzáférés
• Word Control: Word típusú regiszter tartalmától függő hozzáférés
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Bit State Lamp → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Bit State Switch

A „Bit State Switch” elem ötvözi a „Bit State Lamp” és a „Bit State Setting” elemek tulajdonságait.
Jelzi a kijelölt bit állapotát, valamint érintésre módosíthatjuk azt. Az elemet úgy tudjuk a projekthez 
hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző területére. Dupla kattintással elérjük 
az elem beállításait.

A „Basic Attributes” lapon beállíthatjuk, hogy melyik bitet olvassuk (illetve ha nem azonos az 
olvasás és írás bitje) és írjuk.

• Addr. Type: Az olvasni kívánt regiszter típusa.
• Address: A regiszter címe.
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn). 
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Bit State Switch → Bit State Switch 

Beállíthatjuk, hogy az elem megnyomása bekapcsolja (On), kikapcsolja (OFF), állapotot váltson 
(Toggle) vagy amikor megérintjük a gombot a regiszterünk ON állapotba kerül majd miután 
elengedjük OFF állapotba áll (Reset).
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Bit State Switch → Tag 

Ebben a menüben állíthatjuk be az aktuális elem feliratait.
A „Use Tag” jelölőnégyzetét kipipálva beállíthatjuk a különböző állapotokban megjelenítendő 
feliratokat, azok méretét, színét, stílusát.
Ha különböző nyelveket szeretnénk használni, akkor azt is beállíthatjuk, ha már elkészítettük a 
„Text Library” menüben a szükséges feliratokat.
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Bit State Switch → Graphics 

Itt kiválaszthatjuk, hogy a gombunk milyen külalakkal rendelkezzen.
Az „Import Graphics” gombra kattintva válogathatunk a program által felkínált különböző stílusú 
gombok közül. Lehetőségünk van egyedi gombok készítésére is az eszköztárban a „New Graphic” 
ikonra kattintva. 
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Bit State Switch → Control Setting 

Itt beállíthatjuk, hogy az elemünk milyen feltételek mellett legyenek működtethető illetve, milyen 
feltételek mellett módosíthassuk ezt az elemet.

• Always Valid: Mindig módosítható az elem.
• Always Invalid: Sose legyen módosítható az elem. (Itt egy almenübe beállíthatjuk, hogy a 

nem használható elem látható legyen-e.)
• Conditional Enabling: Beállíthatjuk, hogy milyen biztonsági szinten lehessen módosítani 

az elemet, illetve egy másik regiszter tartalmától is függővé tehetjük az elem módosítását.
• Security Level: Biztonsági szint
• Permission Control: Hozzáférés vezérlés
• Register Control: Regiszter vezérelt hozzáférés
• Bit Control: Bit állapotától függő hozzáférés
• Word Control: Word típusú regiszter tartalmától függő hozzáférés
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Bit State Switch → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve azt, hogy milyen feltételek mellett legyen látható az 
elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Direct Window

A „Direct Window” elemmel egy regiszter ON állapotára egy választható ablak ugrik fel, majd az 
OFF állapotra eltűnik. A „Direct Window” elemet csak a vezérlő bittel lehet megnyitni és bezárni, 
méretét érdemes akkorára állítani, mint az ablak, amit meg fog jeleníteni. Egyszerre 16 „Direct 
Window” elemet tudunk megnyitni.
Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző 
területére. Dupla kattintással elérjük az elem beállításait.

A „Read Address” mezőben kiválaszthatjuk, hogy melyik regiszter vezérelje a „Direct Window”.
• Addr. Type: Az olvasni kívánt regiszter típusa.
• Address: A regiszter címe.
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn). 
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Direct Window → Direct Window 

• Frame ID: Megadhatjuk, hogy melyik ablak jelenjen meg a „Direct Window” területen.
• Variable Display Coordinates: Ebben a mezőben beállíthatjuk, hogy a „Direct Window” 

ablakunk melyik koordinátákban jelenjen meg. (LW0= X koordináta, LW1=Y koordináta.)
• Addr. Type: Az olvasni kívánt regiszter típusa.
• Address: A regiszter címe.
• Code Type: BIN, BCD
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Direct Window → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)

Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 
Setting” leírásban lévőnek megfelelő.)
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Multiple State Setting

Ezzel az elemmel adatot tudunk a PLC kijelölt regiszterébe írni.
Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző 
területére. Dupla kattintással elérjük az elem beállításait.

A „Basic Attributes” fülön beállíthatjuk az írni kívánt terület adatait.
• Addr. Type: Az olvasni kívánt regiszter típusa.
• Address: A regiszter címe.
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn). 
• Code Type: BIN, BCD
• Word Length: A küldendő adat hossza.
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Multiple State Setting → Multi-State Setting 

• Setting Mode: Beállíthatjuk, hogy milyen műveletet hajtson végre az elemünk. (A 
következő táblázatban láthatjuk az egyes funkciók jelentését.)

• Variable Parameters: Az itt megjelölt regiszter(ek) tartalmával állíthatjuk a művelet 
elvégzéséhez szükséges adatokat. (Amennyiben „Add value” opciót választjuk a „Addened” 
adatunk a megjelölt területen (LW0) lévő adatot írja át, és az „Upper” adatunk az LW+1 
azaz LW1 lesz.) A küldendő adat hossza 1 illetve 2 szó lehet.

• Set Data Type of The Value: Adatunk típusát választhatjuk ki.
• Addr. Type: Az olvasni kívánt regiszter típusa.
• Address: A regiszter címe.
• Code Type: BIN, BCD
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Set Constans Érintésre a „Set Value” mezőben beállított konstans értéket adja át a 
korábban megjelölt PLC regiszternek.

Set at window open Amikor ezt az elemet tartalmazó ablakot megnyitjuk a „Set Value” mezőben 
beállított konstans értéket adja át a korábban megjelölt PLC regiszternek. 
(Csak az LW területen lévő értéket használhatunk.)

Set at window close Amikor ezt az elemet tartalmazó ablakot bezárjuk a „Set Value” mezőben 
beállított konstans értéket adja át a korábban megjelölt PLC regiszternek.
(Csak az LW területen lévő értéket használhatunk.)

Set at back light OFF Amikor a háttérvilágítás megszűnik a „Set Value” mezőben beállított 
konstans értéket átadja a korábban megjelölt PLC regiszternek

Set at successful 
input

Amikor ezt az elemet tartalmazó ablakon az adatbevitel sikeres a „Set Value” 
mezőben beállított konstans értéket adja át a korábban megjelölt PLC 
regiszternek.

Set at input failure Amikor ezt az elemet tartalmazó ablakon az adatbevitel sikertelen a „Set 
Value” mezőben beállított konstans értéket adja át a korábban megjelölt PLC 
regiszternek.

JOG+ Ameddig nyomva tartjuk ezt az elemet addig a beállításoknak megfelelően 
növeli a korábban megjelölt PLC regiszter tartalmát.
Ha eléri a felső (Upper) határértéket, akkor megáll és megtartja azt.

JOG- Ameddig nyomva tartjuk ezt az elemet addig a beállításoknak megfelelően 
csökkenti a korábban megjelölt PLC regiszter tartalmát.
Ha eléri az alsó (Lower) határértéket, akkor megáll és megtartja azt.

JOG++ Ameddig nyomva tartjuk ezt az elemet addig a beállításoknak megfelelően 
növeli a korábban megjelölt PLC regiszter tartalmát.
Ha eléri a felső (Upper) határértéket, akkor alsó (Lower) határértéktől kezdve 
újraszámol.

JOG-- Ameddig nyomva tartjuk ezt az elemet addig a beállításoknak megfelelően 
növeli a korábban megjelölt PLC regiszter tartalmát.
Ha eléri az alsó (Lower) határértéket, akkor alsó (Lower) határértéktől 
kezdve újraszámol.
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Multiple State Setting → Tag 

Ebben a menüben állíthatjuk be az aktuális elem feliratait.
A „Use Tag” jelölőnégyzetét kipipálva beállíthatjuk a különböző állapotokban megjelenítendő 
feliratokat, azok méretét, színét, stílusát.
Ha különböző nyelveket szeretnénk használni, akkor azt is beállíthatjuk, ha már elkészítettük a 
„Text Library” menüben a szükséges feliratokat.
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Multiple State Setting → Graphics 

Itt kiválaszthatjuk, hogy a gombunk milyen külalakkal rendelkezzen.
Az „Import Graphics” gombra kattintva válogathatunk a program által felkínált különböző stílusú 
gombok közül. Lehetőségünk van egyedi gombok készítésére is az eszköztárban a „New Graphic” 
ikonra kattintva. 
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Multiple State Setting → Control Setting 

Itt beállíthatjuk, hogy az elemünk milyen feltételek mellett legyenek működtethető illetve, milyen 
feltételek mellett módosíthassuk ezt az elemet.

• Always Valid: Mindig módosítható az elem.
• Always Invalid: Sose legyen módosítható az elem. (Itt egy almenübe beállíthatjuk, hogy a 

nem használható elem látható legyen-e.)
• Conditional Enabling: Beállíthatjuk, hogy milyen biztonsági szinten lehessen módosítani 

az elemet, illetve egy másik regiszter tartalmától is függővé tehetjük az elem módosítását.
• Security Level: Biztonsági szint
• Permission Control: Hozzáférés vezérlés
• Register Control: Regiszter vezérelt hozzáférés
• Bit Control: Bit állapotától függő hozzáférés
• Word Control: Word típusú regiszter tartalmától függő hozzáférés
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Multiple State Setting → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Multiple State Display

A „Multiple State Display” elemmel egy többállapotú visszajelzést hozhatunk létre.

Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző 
területére. Dupla kattintással elérjük az elem beállításait.

A „Basic Attributes” fülön beállíthatjuk az írni kívánt terület adatait.
• Addr. Type: Az olvasni kívánt regiszter típusa.
• Address: A regiszter címe.
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn). 
• Code Type: BIN, BCD
• Word Length: A küldendő adat hossza
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Multiple State Display → Multi-Sate Display 

A „Multi-State Display” fülön beállíthatjuk, hogy hány darab állapotot szeretnénk megjeleníteni 
(State Num.(1-256)).
A „Tag” fülön minden egyes állapotot külön-külön elnevezhetünk.
A „Graphics” fülön kiválaszthatjuk a megjelenítési képet az egyes állapotokhoz. (3 különböző 
állapotig találunk gyári ábrákat, ha ezen felül is szeretnénk ábrákat megjeleníteni akkor a „New 
Graphics” menüvel megtehetjük.)
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Multiple State Display → Tag 

Ebben a menüben állíthatjuk be az aktuális elem feliratait.
A „Use Tag” jelölőnégyzetét kipipálva beállíthatjuk a különböző állapotokban megjelenítendő 
feliratokat, azok méretét, színét, stílusát.
Ha különböző nyelveket szeretnénk használni, akkor azt is beállíthatjuk, ha már elkészítettük a 
„Text Library” menüben a szükséges feliratokat.
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Multiple State Display → Graphics 

Itt kiválaszthatjuk, hogy a gombunk milyen külalakkal rendelkezzen.
Az „Import Graphics” gombra kattintva válogathatunk a program által felkínált különböző stílusú 
gombok közül. Lehetőségünk van egyedi gombok készítésére is az eszköztárban a „New Graphic” 
ikonra kattintva. 
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Multiple State Display → Control Setting 

Itt beállíthatjuk, hogy az elemünk milyen feltételek mellett legyenek müködtethető illetve, milyen 
feltételek mellett módosíthassuk ezt az elemet.

• Always Valid: Mindig módosítható az elem.
• Always Invalid: Sose legyen módosítható az elem. (Itt egy almenübe beállíthatjuk, hogy a 

nem használható elem látható legyen-e.)
• Conditional Enabling: Beállíthatjuk, hogy milyen biztonsági szinten lehessen módosítani 

az elemet, illetve egy másik regiszter tartalmától is függővé tehetjük az elem módosítását.
• Security Level: Biztonsági szint
• Permission Control: Hozzáférés vezérlés
• Register Control: Regiszter vezérelt hozzáférés
• Bit Control: Bit állapotától függő hozzáférés
• Word Control: Word típusú regiszter tartalmától függő hozzáférés
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Multiple State Display → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Multiple State Switch

A „Multiple State Switch” ötvözi a „Multiple State Setting” és a „Multiple State Display” elemek 
tulajdonságait. Maximálisan 32 különböző állapotot jelezhetünk ki a PLC regiszter állapotának 
függvényében. Meghatározhatunk a PLC-n olyan területet, amit az elem aktiválása esetén írunk. Ez 
megegyezhet az olvasott területtel, de különböző is lehet.
Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző 
területére. Dupla kattintással elérjük az elem beállításait.

A „Basic Attributes” fülön beállíthatjuk az írni kívánt terület adatait.
A „Read Address Same As Write Address” jelölőnégyzet üresen hagyásával különböző területet 
olvashatunk és írhatunk.

• Addr. Type: Az olvasni (írni) kívánt regiszter típusa.
• Address: A regiszter címe.
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn). 
• Code Type: BIN, BCD
• Word Length: A küldendő adat hossza.
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Multiple State Switch → Multi-State Switch 

• Control Mode: Művelet típusának meghatározása.
• State Num: Állapotok száma.
• Line Spacing: Mező vastagsága.

„Unloop” jelölőnégyzet kijelölésével a gombot nyomkodva az utolsó állapot után az első állapotra 
ugrik vissza.
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Multiple State Switch → Tag 

Ebben a menüben állíthatjuk be az aktuális elem feliratait.
A „Use Tag” jelölőnégyzetét kipipálva beállíthatjuk a különböző állapotokban megjelenítendő 
feliratokat, azok méretét, színét, stílusát.
Ha különböző nyelveket szeretnénk használni, akkor azt is beállíthatjuk, ha már elkészítettük a 
„Text Library” menüben a szükséges feliratokat.
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Multiple State Switch → Graphics 

Itt kiválaszthatjuk, hogy a gombunk milyen külalakkal rendelkezzen.
Az „Import Graphics” gombra kattintva válogathatunk a program által felkínált különböző stílusú 
gombok közül. Lehetőségünk van egyedi gombok készítésére is az eszköztárban a „New Graphic” 
ikonra kattintva. 
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Multiple State Switch → Control Setting 

Itt beállíthatjuk, hogy az elemünk milyen feltételek mellett legyenek működtethető illetve, milyen 
feltételek mellett módosíthassuk ezt az elemet.

• Always Valid: Mindig módosítható az elem.
• Always Invalid: Sose legyen módosítható az elem. (Itt egy almenübe beállíthatjuk, hogy a 

nem használható elem látható legyen-e.)
• Conditional Enabling: Beállíthatjuk, hogy milyen biztonsági szinten lehessen módosítani 

az elemet, illetve egy másik regiszter tartalmától is függővé tehetjük az elem módosítását.
• Security Level: Biztonsági szint
• Permission Control: Hozzáférés vezérlés
• Register Control: Regiszter vezérelt hozzáférés
• Bit Control: Bit állapotától függő hozzáférés
• Word Control: Word típusú regiszter tartalmától függő hozzáférés
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Multiple State Switch → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Scroll Bar

A „Scroll Bar” elemmel egy csuszkát hozhatunk létre, melyet mozgatva a beállított regisztert a 
csuszka helyzetének megfelelő értékkel tölti fel.
Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző 
területére. Dupla kattintással elérjük az elem beállításait.

A „Basic Attributes” fülön beállíthatjuk az írni kívánt terület adatait.
• Addr. Type: Az olvasni kívánt regiszter típusa.
• Address: A regiszter címe.
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn). 
• Code Type: BIN, BCD
• Word Length: A küldendő adat hossza.
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Scroll Bar → Scroll Bar 

• Word Length of Index Number: Word, Double Word
• Direction: A csuszka irányát állíthatjuk be.
• Background Image: Csuszka hátterének stílusát állíthatjuk be.
• Button Image: Csúszkán lévő gomb stílusát állíthatjuk be.
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Scroll Bar → Scroll Bar Extended Attributes

• Slider Width: Ha kijelöljük, állíthatjuk a csúszkán lévő gomb vastagságát.
• Max/Min Value Setting: Max/Min értékek beállítása

• Min: Csúszka minimum értéke.
• Max: Csúszka maximum értéke.

• Variable Max/Min Value: Változóval is megadhatjuk a Max/Min értékeket. 
A kijelölt terület (LW1) a Min. érték a kijelölt +1 (LW2) a Max. érték.

• Addr. Type: Az olvasni kívánt regiszter típusa.
• Address: A regiszter címe.
• Code Type: BIN, BCD

67.



Scroll Bar → Graphics 

Itt kiválaszthatjuk, hogy a gombunk milyen külalakkal rendelkezzen.
Az „Import Graphics” gombra kattintva válogathatunk a program által felkínált különböző stílusú 
gombok közül. Lehetőségünk van egyedi gombok készítésére is az eszköztárban a „New Graphic” 
ikonra kattintva. 
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Scroll Bar → Control Setting 

Itt beállíthatjuk, hogy az elemünk milyen feltételek mellett legyenek működtethető illetve, milyen 
feltételek mellett módosíthassuk ezt az elemet.

• Always Valid: Mindig módosítható az elem.
• Always Invalid: Sose legyen módosítható az elem. (Itt egy almenübe beállíthatjuk, hogy a 

nem használható elem látható legyen-e.)
• Conditional Enabling: Beállíthatjuk, hogy milyen biztonsági szinten lehessen módosítani 

az elemet, illetve egy másik regiszter tartalmától is függővé tehetjük az elem módosítását.
• Security Level: Biztonsági szint
• Permission Control: Hozzáférés vezérlés
• Register Control: Regiszter vezérelt hozzáférés
• Bit Control: Bit állapotától függő hozzáférés
• Word Control: Word típusú regiszter tartalmától függő hozzáférés
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Scroll Bar → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)

Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 
Setting” leírásban lévőnek megfelelő.)
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Moving Component

A „Moving Component” eszközzel olyan elemet hozhatunk létre, mely a PLC regisztereinek 
állapotától függően különböző állapotokat és pozíciókat vehet fel. 
Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző 
területére. Dupla kattintással elérjük az elem beállításait.

A megjelölt PLC regisztere az állapotát, a regiszter+1 az X tengely menti elmozdulást, a regiszter+2 
az Y tengely menti elmozdulást vezérli.

Control 
Mode

X Y X&Y

Olvasott adat 
hossza

2 word 2 word 3 word

Regiszter cím Elem állapota Elem állapota Elem állapota
Regiszter cím 
+1

X elmozdulás Y elmozdulás X elmozdulás

Regiszter cím 
+2

- - Y elmozdulás
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Moving Component → Basic Attributes 

• Addr. Type: Az olvasni kívánt regiszter típusa.
• Address: A regiszter címe.
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn). 
• Code Type: BIN, BCD
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Moving Component → Moving Component 

„Type” legördülő menüben kiválaszthatjuk a mozgatás típusát. A következő táblázatban ezt 
részletezzük.
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Moving Component → Mozgások típusai:

X Axis Only X irányú elmozdulás
Y Axis Only Y irányú elmozdulás
X&Y Axis X és Y irányú elmozdulás
X Scaling X irányú elmozdulás (korlátozható)
Y Scaling Y irányú elmozdulás (korlátozható)
X Reverse Scaling Fordított X irányú elmozdulás (korlátozható)
Y Reverse Scaling Fordított Y irányú elmozdulás (korlátozható)
X Scaling, Y Scaling X és Y irányú elmozdulás (korlátozható)
X Scaling, Y Reverse 
Scaling

X normál irányú és Y fordított irányú elmozdulás 
(korlátozható)

X Reverse Scaling, Y 
Scaling

X fordított irányú és Y normál irányú elmozdulás 
(korlátozható)

X Reverse Scaling, Y 
Reverse Scaling

X és Y fordított irányú elmozdulás (korlátozható)
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Moving Component → Tag 

Ebben a menüben állíthatjuk be az aktuális elem feliratait.
A „Use Tag” jelölőnégyzetét kipipálva beállíthatjuk a különböző állapotokban megjelenítendő 
feliratokat, azok méretét, színét, stílusát.
Ha különböző nyelveket szeretnénk használni, akkor azt is beállíthatjuk, ha már elkészítettük a 
„Text Library” menüben a szükséges feliratokat.
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Moving Component → Graphics 

Itt kiválaszthatjuk, hogy a gombunk milyen külalakkal rendelkezzen.
Az „Import Graphics” gombra kattintva válogathatunk a program által felkínált különböző stílusú 
gombok közül. Lehetőségünk van egyedi gombok készítésére is az eszköztárban a „New Graphic” 
ikonra kattintva. 
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Moving Component → Control Setting 

Itt beállíthatjuk, hogy az elemünk milyen feltételek mellett legyenek működtethető illetve, milyen 
feltételek mellett módosíthassuk ezt az elemet.

• Always Valid: Mindig módosítható az elem.
• Always Invalid: Sose legyen módosítható az elem. (Itt egy almenübe beállíthatjuk, hogy a 

nem használható elem látható legyen-e.)
• Conditional Enabling: Beállíthatjuk, hogy milyen biztonsági szinten lehessen módosítani 

az elemet, illetve egy másik regiszter tartalmától is függővé tehetjük az elem módosítását.
• Security Level: Biztonsági szint
• Permission Control: Hozzáférés vezérlés
• Register Control: Regiszter vezérelt hozzáférés
• Bit Control: Bit állapotától függő hozzáférés
• Word Control: Word típusú regiszter tartalmától függő hozzáférés
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Moving Component → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Animation

„Animation” eszközzel egy általunk meghatározott pályán tudunk egy elemet mozgatni a PLC 
megjelölt regiszterének tartalmától függően.
Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző 
területére. Miután behúztuk a kijelző területre az egérrel kattintgatva megadhatjuk a pálya pontjait 
(a pontok egymás után követik egymást). Ha megrajzoltuk a pontokat az egér jobb gombjával 
kattintva lezárjuk a pályát és a beállítás párbeszéd ablak előugrik. A pályát utólag is tudjuk 
módisítani.

• Addr. Type: Az olvasni kívánt regiszter típusa.
• Address: A regiszter címe.
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn). 
• Code Type: BIN, BCD
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Animation → Animation 

Ezen a fülön láthatjuk a felvett pontok koordinátáit, valamint itt 
hozzáadhatunk/törölhetünk/eltolhatunk pontokat.
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Animation →  Tag 

Ebben a menüben állíthatjuk be az aktuális elem feliratait.
A „Use Tag” jelölőnégyzetét kipipálva beállíthatjuk a különböző állapotokban megjelenítendő 
feliratokat, azok méretét, színét, stílusát.
Ha különböző nyelveket szeretnénk használni, akkor azt is beállíthatjuk, ha már elkészítettük a 
„Text Library” menüben a szükséges feliratokat.
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Animation → Graphics 

Itt kiválaszthatjuk, hogy a gombunk milyen külalakkal rendelkezzen.
Az „Import Graphics” gombra kattintva válogathatunk a program által felkínált különböző stílusú 
gombok közül. Lehetőségünk van egyedi gombok készítésére is az eszköztárban a „New Graphic” 
ikonra kattintva. 
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Animation →  Control Setting 

Itt beállíthatjuk, hogy az elemünk milyen feltételek mellett legyenek működtethető illetve, milyen 
feltételek mellett módosíthassuk ezt az elemet.

• Always Valid: Mindig módosítható az elem.
• Always Invalid: Sose legyen módosítható az elem. (Itt egy almenübe beállíthatjuk, hogy a 

nem használható elem látható legyen-e.)
• Conditional Enabling: Beállíthatjuk, hogy milyen biztonsági szinten lehessen módosítani 

az elemet, illetve egy másik regiszter tartalmától is függővé tehetjük az elem módosítását.
• Security Level: Biztonsági szint
• Permission Control: Hozzáférés vezérlés
• Register Control: Regiszter vezérelt hozzáférés
• Bit Control: Bit állapotától függő hozzáférés
• Word Control: Word típusú regiszter tartalmától függő hozzáférés
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Animation → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Alarm Display

Az „Alarm Display” eszközzel az előre beállított vészjelzéseket tudjuk megjeleníteni. Addig 
megjelenítve marad a vészjelzés, amíg a vészjelző vezérlő bitje a normál állapotba visszaáll.
(Ezzel az eszközzel csak az „Alarm Information Logon” eszközben megadott hibákat jelezhetjük ki)
Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző 
területére. Dupla kattintással elérjük az elem beállításait.

• Addr. Type: Az olvasni kívánt regiszter típusa.
• Address: A regiszter címe.
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn). 
• Code Type: BIN, BCD
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Alarm Display → Alarm Display 

Ezen a fülön megadhatjuk a megjelenítés formai paramétereit.
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Alarm Display → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Trend Curve

A „Trend Curve” eszközzel valós időben tudunk változásokat grafikonon megjeleníteni.
Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző 
területére. Dupla kattintással elérjük az elem beállításait.

• Addr. Type: Az olvasni kívánt regiszter típusa.
• Address: A regiszter címe.
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn). 
• Code Type: BIN, BCD
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Trend Curve → Trend Graphics 

• Type: „Single page” (csak az aktuális értékeket láthatjuk), „Multiple page” („PageNum” 
mezőben megadhatjuk, hogy hány oldalt tudjunk visszalapozni).

• Property: Beállíthatjuk, hogy a megjelenítés melyik irányból kezdődjön.
• Sam.Type: Mintavételezés típusa („Once”-egyszer, „Continous”-folyamatos).
• Sampling Methods: Mintavételezés módja.

Time sampling Idő alapú mintavételezés
OFF->ON trigger sampling OFF->ON állapotváltásra vezérelt
ON->OFF trigger sampling ON->OFF állapotváltásra vezérelt
OFF<->ON trigger sampling OFF<->ON állapotváltásra vezérelt
OFF->ON reset trigger 
sampling

OFF->ON reset-re vezérelt

OFF<-ON reset trigger 
sampling

OFF<-ON reset-re vezérelt

• Cycle: Mintavételezés ciklusideje.
• Sampling points: Mintavételek száma.
• Channel: Csatornák száma.
• Trigger Register Setting: Trigger jelre történő mintavételezés esetén itt állíthatjuk be, hogy 

melyik regiszter adja a trigger jelet.
• SCRO: „Multiple page” kiválasztása esetén az „SCRO” mezőben beállított regiszterrel 

tudunk lapozni az oldalak között.
• Pause-Clear(ClearAddr=ResetAdrr+1): Mintavételezést megállíthatjuk, törölhetjük a 

görbéket
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Trend Curve → Channel 

Beállíthatjuk a csatornáink Adattípusát („DataType”), minimumát („Y Min”), maximumát („Y 
Max”) valamint a színeit.
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Trend Curve → Extended Attributes 

Beállíthatjuk csatornáink megjelenését.
• Variable Period: Periódusidőt változtathatjuk a megjelölt regiszter függvényében.
• Number of Points: Mintavételezési pontokat módosíthatjuk. (Ha nincs kapcsolat a plc-vel a 

rendszer az alapértelmezett beállítást használja.)
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Trend Curve → Scale 

• Horizontal Scroll Bar: Vízszintes csúszka.
• Vertical Axis Scale Reference Channel: Függőleges tengely referencia csatornája.
• Use Vertical Axis Scale: Függőleges tengely skála tulajdonságai.
• Use Horisontal Axis Time Scale: Vízszintes tengely idő skála tulajdonságai.
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Trend Curve → Save Historical Data 

• Save to Recipe Data Field: Nemfelejtő területre mentünk
• Save as CSV: CSV formátumban menthetjük adatainkat
• External Device: USB/SD kártya
• Subdirectory: Annak a mappának a neve, ahova mentjük az adatokat
• Trigger para: Triggerelhetjük, hogy milyen feltétel esetén végezze a kimentést

• Save to External Device: Közvetlenül menthetünk küldő adathordozóra
• Storage Devices: USB/SD kártya
• Subdirectory: Annak a mappának a neve, ahova mentjük az adatokat
• Storage Type: Daily File- naponta kerül külön fájlba a mért adat
• Single File- minden adat külön fájlba kerül
• Bulk Storage: Mentés területének mérete
• Max Storage: Mentés hány napig tartson (ha itt nulla van, akkor a tárhely határozza 

meg)
• Variable Subdirectory: Változtathatjuk, hogy melyik nevű mappába mentsük adatainkat
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Trend Curve → Print

• Open printing: Nyomtatás funkció aktiválása
• Net Print: Hálózati nyomtatóval való nyomtatás
• Mode: Nyomtatást vezérlő módok

• Print per point: Pontonkénti nyomtatás
• Print per page: Oldalankénti nyomtatás
• Print whole: Minden oldal nyomtatása
• Trigger by register: Regiszter állapotától függő triggerelés

• Paper Width: Papír szélessége
• Print axis: Tengelyek nyomtatása
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Trend Curve → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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XY Plot

Az „XY Plot” eszközzel két változó értéket jeleníthetünk meg egy görbén. Két szomszédos word 
regiszter alkot egy párt. Az alsó word az X tengely értékeit, a felső word az Y tengely értékeit 
tartalmazza. Két pont együttesen alkotnak egy mintavételezési pontot. 
Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző 
területére. Dupla kattintással elérjük az elem beállításait.

• Addr. Type: Az olvasni kívánt regiszter típusa
• Address: A regiszter címe
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn)
• Code Type: BIN, BCD
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XY Plot → XY Curve Graphics 

• Type: „Single page” (csak az aktuális értékeket láthatjuk), „Multiple page” („PageNum” 
mezőben megadhatjuk, hogy hány oldalt tudjunk visszalapozni)

• Property: Beállíthatjuk, hogy a megjelenítés melyik irányból kezdődjön
• Sampling Methods: Mintavételezés módja

Time sampling Idő alapú mintavételezés
OFF->ON trigger sampling OFF->ON állapotváltásra vezérelt
ON->OFF trigger sampling ON->OFF állapotváltásra vezérelt
OFF<->ON trigger sampling OFF<->ON állapotváltásra vezérelt
OFF->ON reset trigger 
sampling

OFF->ON reset-re vezérelt

OFF<-ON reset trigger 
sampling

OFF<-ON reset-re vezérelt
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• Cycle: Mintavételezés ciklusideje
• Sampling points: Mintavételek száma
• Channel: Csatornák száma
• Trigger Register Setting: Trigger jelre történő mintavételezés esetén itt állíthatjuk be, hogy 

melyik regiszter adja a trigger jelet
• SCRO: „Multiple page” kiválasztása esetén az „SCRO” mezőben beállított regiszterrel 

tudunk lapozni az oldalak között
• Pause-Clear(ClearAddr=ResetAdrr+1): Mintavételezést megállíthatjuk, törölhetjük a 

görbéket

XY Plot → Channel

Beállíthatjuk a csatornáink adattípusát („DataType”), minimumát („X Min.”/„Y Min”), maximumát 
(„X MAX”/„Y Max”) valamint a színeit.
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XY Plot → Extended Attributes 

Beállíthatjuk csatornáink megjelenését.
• Variable Period: Periódusidőt változtathatjuk a megjelölt regiszter függvényében
• Number of Points: Mintavételezési pontokat módosíthatjuk. (Ha nincs kapcsolat a plc-vel a 

rendszer az alapértelmezett beállítást használja)
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XY Plot → Save Historycal Data 

• Save to Recipe Data Field: Nemfelejtő területre mentjük
• Save as CSV: CSV formátumban menthetjük adatainkat

• External Device: USB/SD kártya
• Subdirectory: Annak a mappának a neve ahova mentjük az adatokat
• Trigger para: Triggerelhetjük, hogy milyen feltétel esetén végezze a kimentést

• Save to External Device: Közvetlenül menthetünk küldő adathordozóra
• Storage Devices: USB/SD kártya
• Subdirectory: Annak a mappának a neve ahova mentjük az adatokat
• Storage Type: Daily File- naponta kerül külön fájlba a mért adat

Single File- minden adat külön fájlba kerül
• Bulk Storage: Mentés területének mérete
• Max Storage: Mentés hány napig tartson (ha itt nulla van akkor a tárhely határozza 

meg)
• Variable Subdirectory: Változtathatjuk, hogy melyik nevű mappába mentsük adatainkat
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XY Plot → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve azt, hogy milyen feltételek mellett legyen látható az 
elem.

Always Display:Mindig látható.
Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control Setting” 

leírásban lévőnek megfelelő.)
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Bar Picture

A „Bar Picture” eszközzel a PLC regiszter tartalmát jeleníthetjük meg oszlopdiagram formájában.
Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző 
területére. Dupla kattintással elérjük az elem beállításait.

• Addr. Type: Az olvasni kívánt regiszter típusa
• Address: A regiszter címe
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn)
• Code Type: BIN, BCD
• Word Length: Regiszter mérete (1-2 word)
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Bar Picture → Bar 

• Bar Type: Normál, szakaszos
• Art Direction: Fel, le, balra, jobbra
• Bar Shape: Téglalap, kör
• Target Value: Cél érték
• Permission Error: Megengedhető hiba
• Border: Ábra szegélye
• Background: Háttér
• Data Type: Adattípus
• Over Upper Limit Flashing: Felső limit elérése után villog
• Over Lower Limit Flashing: Alsó limit elérése után villog
• Variable Min/Max: Változtatható Min/Max érték
• Variable Alarm Lower/Upper: Változtatható Vész érték alsó és felső határ

• Addr. Type: Az olvasni kívánt regiszter típusa
• Address: A regiszter címe
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn).
• Code Type: BIN, BCD
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Bar Picture → Scale 

• Use Scale: Skála használata
• Scale Color: Skála színe
• The Number of Main Scale: Fő skála értékeinek száma
• The Length of Main Scale: Fő skála hossza
• The Number of Minor Scale: Rész skála értékeinek száma
• The Length of Minor Scale: Rész skála hossza
• Scale display position: Skála elhelyezése
• Use Scale Tag: Skála formátum
• Integer: Egész szám
• Decimal: Tizedes
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Bar Picture → Graphics 

Itt kiválaszthatjuk, hogy a gombunk milyen külalakkal rendelkezzen.
Az „Import Graphics” gombra kattintva válogathatunk a program által felkínált különböző stílusú 
gombok közül. Lehetőségünk van egyedi gombok készítésére is az eszköztárban a „New Graphic” 
ikonra kattintva. 
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Bar Picture → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)

106.



Meter

A „Meter”, műszer eszközzel analóg módon jeleníthetünk meg egy megjelölt PLC regiszter 
tartalmat, a skála beállított maximuma és minimuma között.
Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző 
területére. Dupla kattintással érjük el az elem beállításait.

• Addr. Type: Az olvasni kívánt regiszter típusa
• Address: A regiszter címe
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn)
• Code Type: BIN, BCD
• Word Length: Regiszter mérete (1-2 word)
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Meter → Meter Component 

• Data Type: Adattípus
Dial Style: Tárcsa stílusa

• Pie: Félkör
• Circularity (point up): Teljes kör föntről kezdődően
• Circularity (point up): Teljes kör lentről kezdődően

• Hand style: Mutató stílusa
• Use Scale: Skála használata
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Meter → Meter Component Extended Attribute 

• Maximum and Minimum: Maximum és minimum értékek megadása
• Variable Min/Max: Változtatható maximum és minimum értékek

• Addr. Type: Az olvasni kívánt regiszter típusa
• Address: A regiszter címe
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn)
•  Type: BIN, BCD

• Alarm: Vészjelzés
• Addr. Type: Az olvasni kívánt regiszter típusa
• Address: A regiszter címe
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn) 
• Code Type: BIN, BCD

• Variable Lower/Upper Limit: Változtatható alsó és felső határ
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Meter → Graphics 

Itt választhatjuk ki, hogy a gombunk milyen külalakkal rendelkezzen.
Az „Import Graphics” gombra kattintva válogathatunk a program által felkínált különböző stílusú 
gombok közül. Lehetőségünk van egyedi gombok készítésére is az eszköztárban a „New Graphic” 
ikonra kattintva. 
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Meter → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Recipe Data

A „Recipe Data” eszközzel adatokat mozgathatunk a kijelző memóriájából a PLC-re, vagy a PLC-
ről a kijelzőre. 
Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző 
területére. Dupla kattintással elérjük az elem beállításait.

• Addr. Type: Az olvasni kívánt regiszter típusa
• Address: A regiszter címe
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn) 
• Code Type: BIN, BCD
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Recipe Data → Recipe Data 

• Function: Adatcsere funkciója 

Upload from PLC to Recipe Feltöltés a PLC-ről a Recipe területre
Download from Recipe to PLC Letöltés a Recipe területről a PLC-re
Upload from PLC to ERW0 Feltöltés a PLC-ről az ERW0 területre
Download from ERW0 to PLC Letöltés az ERW0 területről a PLC-re
Upload from PLC to ERW1 Feltöltés a PLC-ről az ERW1 területre
Download from ERW1 to PLC Letöltés az ERW1 területről a PLC-re
Upload from PLC to ERW2 Feltöltés a PLC-ről az ERW2 területre
Download from ERW2 to PLC Letöltés az ERW2 területről a PLC-re
Upload from PLC to FRW Feltöltés a PLC-ről az FRW területre
Download from FRW to PLC Letöltés az FRW területről a PLC-re

• Data Length: Adatunk hossza 
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Recipe Data → Tag 

Ebben a menüben állíthatjuk be az aktuális elem feliratait.
A „Use Tag” jelölőnégyzetét kipipálva beállíthatjuk a különböző állapotokban megjelenítendő 
feliratokat, azok méretét, színét, stílusát.
Ha különböző nyelveket szeretnénk használni, akkor azt is beállíthatjuk, ha már elkészítettük a 
„Text Library” menüben a szükséges feliratokat.

114.



Recipe Data → Graphics 

Itt kiválaszthatjuk, hogy a gombunk milyen külalakkal rendelkezzen.
Az „Import Graphics” gombra kattintva válogathatunk a program által felkínált különböző stílusú 
gombok közül. Lehetőségünk van egyedi gombok készítésére is az eszköztárban a „New Graphic” 
ikonra kattintva. 
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Recipe Data → Control Setting 

Itt beállíthatjuk, hogy az elemünk milyen feltételek mellett legyenek működtethető illetve, milyen 
feltételek mellett módosíthassuk ezt az elemet.

• Always Valid: Mindig módosítható az elem.
• Always Invalid: Sose legyen módosítható az elem. (Itt egy almenübe beállíthatjuk, hogy a 

nem használható elem látható legyen-e.)
• Conditional Enabling: Beállíthatjuk, hogy milyen biztonsági szinten lehessen módosítani 

az elemet, illetve egy másik regiszter tartalmától is függővé tehetjük az elem módosítását.
• Security Level: Biztonsági szint
• Permission Control: Hozzáférés vezérlés
• Register Control: Regiszter vezérelt hozzáférés
• Bit Control: Bit állapotától függő hozzáférés
• Word Control: Word típusú regiszter tartalmától függő hozzáférés
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Recipe Data → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Event Display

Az „Event Display” eszközzel különböző események bekövetkezésének naplózását valósíthatjuk 
meg. Csak akkor tudunk megjeleníteni eseményt, ha korábban az „Event Information Logon” 
menüben létrehoztuk, hogy milyen feltétel mellett milyen eseményt szeretnénk kijelezni.
Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző 
területére. Dupla kattintással elérjük az elem beállításait.

• Addr. Type: Az olvasni kívánt regiszter típusa
• Address: A regiszter címe
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn) 
• Code Type: BIN, BCD
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Event Display → Event Information 

• Display Type Range: Kijelezni kívánt esemény típus tartománya (a típust az „Event 
Information Logon” menüben adhatjuk meg)

• Sequence No. Lenght: Sorszám hossza
• Row Space: Sor mérete
• CharacerSpace: Karakterek mérete
• Acknowledge Type: Nyugtázás típusa (1 vagy dupla kattintás)
• BorderWidth: Keret vastagság
• Background Color: Háttérszín
• Horizontal Line: Vízszintes vonal megjelenésének formázása
• Vertical Line: Függőleges vonal megjelenésének formázása
• Clear Event One By One: Esemény törlés (a kijelölt eseményt a kiválasztott bittel a 

triggerjeltől függően törölhetjük)
• Addr. Type: Az olvasni kívánt regiszter típusa
• Address: A regiszter címe
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn) 
• Code Type: BIN, BCD
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Event Display → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve azt, hogy milyen feltételek mellett legyen látható az 
elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Indirect Window

Az „Indirect Window” eszközzel kijelölt területen, egy regiszter tartalommal előhívhatunk, illetve 
eltüntethetünk ablakokat.
 Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző 
területére. Dupla kattintással elérjük az elem beállításait.

• Addr. Type: Az olvasni kívánt regiszter típusa
• Address: A regiszter címe
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn) 
• Code Type: BIN, BCD
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Indirect Window → Indirect Window 

• Addr. Type: Az olvasni kívánt regiszter típusa
• Address: A regiszter címe
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn) 
• Code Type: BIN, BCD
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Indirect Window → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Number Display

A „Number Display” eszközzel a PLC regiszterének tartalmát tudjuk számok formájában 
megjeleníteni.
Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző 
területére. Dupla kattintással elérjük az elem beállításait.

• Addr. Type: Az kiírni kívánt regiszter típusa
• Address: A regiszter címe
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn) 
• Code Type: BIN, BCD
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Number Display → Numeric Data 

• Data Type: Adattípus
• Data Width: WORD, DWORD
• Integer: Egész szám
• Decimal: Tizedes jegy
• Max/Min Value Setting: Max/Min értékek beállítása
• Variable Min/Max: Változtatható Min/Max érték
• Variable Alarm Lower/Upper: Változtatható Vész érték alsó és felső határ
• Addr. Type: Az olvasni kívánt regiszter típusa
• Address: A regiszter címe
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn) 
• Code Type: BIN, BCD
• Off Normal Upper: Ha a maximális értéknél nagyobbat írunk be a kijelzett szám színét 

változtathatjuk (Flash jelölőnégyzetet kipipáljuk villogni fog ha nagyobb a beírt érték mint a 
Max.)

• OFF Normal Lower: Ha a minimális értéknél kisebbet írunk be a kijelzett szám színét 
változtathatjuk (Flash jelölőnégyzetet kipipáljuk villogni fog ha kisebb a beírt érték mint a 
Min.)

• Proportion Conversion: Arányos átszámítás, „skálázás”
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Number Display → Graphics 

Itt kiválaszthatjuk, hogy a gombunk milyen külalakkal rendelkezzen.
Az „Import Graphics” gombra kattintva válogathatunk a program által felkínált különböző stílusú 
gombok közül. Lehetőségünk van egyedi gombok készítésére is az eszköztárban a „New Graphic” 
ikonra kattintva. 
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Number Display → Control Setting 

Itt beállíthatjuk, hogy az elemünk milyen feltételek mellett legyenek működtethető illetve, milyen 
feltételek mellett módosíthassuk ezt az elemet.

• Always Valid: Mindig módosítható az elem.
• Always Invalid: Sose legyen módosítható az elem. (Itt egy almenübe beállíthatjuk, hogy a 

nem használható elem látható legyen-e.)
• Conditional Enabling: Beállíthatjuk, hogy milyen biztonsági szinten lehessen módosítani 

az elemet, illetve egy másik regiszter tartalmától is függővé tehetjük az elem módosítását.
• Security Level: Biztonsági szint
• Permission Control: Hozzáférés vezérlés
• Register Control: Regiszter vezérelt hozzáférés
• Bit Control: Bit állapotától függő hozzáférés
• Word Control: Word típusú regiszter tartalmától függő hozzáférés
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Number Display → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Number Input

A „Number Input” eszközzel számokat vihetünk be a kijelzőről.
Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző 
területére. Dupla kattintással elérjük az elem beállításait.

• Read Address Same As Write Address: A jelölőnégyzet üresen hagyásával különböző 
területet olvashatunk és írhatunk, bejelölve ugyanaz az írás és olvasás mező

• Addr. Type: Az írni kívánt regiszter típusa
• Address: A regiszter címe
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn)
• Code Type: BIN, BCD
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Number Input → Numeric Data 

• Data Type: Adattípus
• Data Width: WORD, DWORD
• Integer: Egész szám
• Decimal: Tizedes jegy
• Max/Min Value Setting: Max/Min értékek beállítása
• Variable Min/Max: Változtatható Min/Max érték
• Variable Alarm Lower/Upper: Változtatható Vész érték alsó és felső határ
• Addr. Type: Az olvasni kívánt regiszter típusa
• Address: A regiszter címe
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn) 
• Code Type: BIN, BCD
• Off Normal Upper: Ha a maximális értéknél nagyobbat írunk be a kijelzett szám színét 

változtathatjuk (Flash jelölőnégyzetet kipipáljuk villogni fog ha nagyobb a beírt érték mint a 
Max.)

• OFF Normal Lower: Ha a minimális értéknél kisebbet írunk be a kijelzett szám színét 
változtathatjuk (Flash jelölőnégyzetet kipipáljuk villogni fog ha kisebb a beírt érték mint a 
Min.)

• Proportion Conversion: Arányos átszámítás
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Number Input → Keyboard Setting 

• Keyboard Setting: Billentyűzet beállítása
• Public Windows Keyboard: Windows billentyűzet kiosztás

Specified Keyboard: Speciális billentyűzet (NUM Keyboard, ASCII Keyboard, HEX 
Keyboard)

• Keyboard Pop-up Position (HMI Screen Position): Billentyűzet helyzete a kijelzőn
• Not Use Pop-up Keyboard (Input by Map Key or External Keyboard): Ne használjon 

felugró billentyűzetet (bevitel külön gombbal vagy külső billentyűzettel történik)
• Use Input Order: A számbevitelt folyamatossá tehetjük. A billentyűzet csak akkor tűnik el 

ha a piros X-el kikapcsoljuk
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Number Input → Graphics 

Itt kiválaszthatjuk, hogy a gombunk milyen külalakkal rendelkezzen.
Az „Import Graphics” gombra kattintva válogathatunk a program által felkínált különböző stílusú 
gombok közül. Lehetőségünk van egyedi gombok készítésére is az eszköztárban a „New Graphic” 
ikonra kattintva. 
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Number Input → Control Setting 

Itt beállíthatjuk, hogy az elemünk milyen feltételek mellett legyenek működtethető, illetve milyen 
feltételek mellett módosíthassuk ezt az elemet.

• Always Valid: Mindig módosítható az elem.
• Always Invalid: Soha ne legyen módosítható az elem. (Itt egy almenüben beállíthatjuk, 

hogy a nem használható elem látható legyen-e.)
• Conditional Enabling: Beállíthatjuk, hogy milyen biztonsági szinten lehessen módosítani 

az elemet, illetve egy másik regiszter tartalmától is függővé tehetjük az elem módosítását.
• Security Level: Biztonsági szint
• Permission Control: Hozzáférés vezérlés
• Register Control: Regiszter vezérelt hozzáférés
• Bit Control: Bit állapotától függő hozzáférés
• Word Control: Word típusú regiszter tartalmától függő hozzáférés

133.



Number Input → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Text Display

A „Text Display” eszközzel szöveget jelezhetjük ki a kijelzőn.
Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző 
területére. Dupla kattintással elérjük az elem beállításait.

• Addr. Type: Az kiírni kívánt regiszter típusa
• Address: A regiszter címe
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn) 
• Code Type: BIN, BCD
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Text Display → Graphics 

Itt kiválaszthatjuk, hogy a gombunk milyen külalakkal rendelkezzen.
Az „Import Graphics” gombra kattintva válogathatunk a program által felkínált különböző stílusú 
gombok közül. Lehetőségünk van egyedi gombok készítésére is az eszköztárban a „New Graphic” 
ikonra kattintva. 
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Text Display → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve azt, hogy milyen feltételek mellett legyen látható az 
elem.

• Always Display: Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Text Input

A „Text Input” eszközzel szöveget vihetünk be a kijelzőről.
Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző 
területére. Dupla kattintással elérjük az elem beállításait.

• High byte and low byte swaps: Felcseréli az MSB és az LSB pozícióját egy bájton belül
• Addr. Type: A kiírni kívánt regiszter típusa
• Address: A regiszter címe
• Code Type: BIN, BCD
• Word Length: A szó hossza
• Use the index register: Indexelhetjük regiszterünket
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn)
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Text Input → Graphics 

Itt kiválaszthatjuk, hogy a gombunk milyen külalakkal rendelkezzen.
Az „Import Graphics” gombra kattintva válogathatunk a program által felkínált különböző stílusú 
gombok közül. Lehetőségünk van egyedi gombok készítésére is az eszköztárban a „New Graphic” 
ikonra kattintva. 
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Text Input → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Oscillograph

Az „Oscillograph”, oszcilloszkóp eszköz hasonló a „Trend Curve” eszközhöz, azzal a különbséggel, 
hogy az „Oscillograph” eszköz csak akkor gyűjt adatot, amikor az ablak aktív, amelyiken ez az 
elem el van helyezve. Előnye, hogy többféle hullámformát képes megjeleníteni, melyeknek 
monitorozása csak az adott időpillanatban fontos.
Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző 
területére. Dupla kattintással elérjük az elem beállításait.

• Addr. Type: A kiírni kívánt regiszter típusa
• Address: A regiszter címe
• Code Type: BIN, BCD
• Word Length: A szó hossza
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn)
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Oscillograph → Scope Chart 

• Type: „Single page” (csak az aktuális értékeket láthatjuk), „Multiple page” („PageNum” 
mezőben megadhatjuk, hogy hány oldalt tudjunk visszalapozni)

• Property: Beállíthatjuk, hogy a megjelenítés melyik irányból kezdődjön
• Sampling Methods: Mintavételezés módja

Time sampling Idő alapú mintavételezés
OFF->ON trigger sampling OFF->ON állapotváltásra vezérelt
ON->OFF trigger sampling ON->OFF állapotváltásra vezérelt
OFF<->ON trigger sampling OFF<->ON állapotváltásra vezérelt
OFF->ON reset trigger sampling OFF->ON reset-re vezérelt
OFF<-ON reset trigger sampling OFF<-ON reset-re vezérelt

• Cycle: Mintavételezés ciklusideje
• Sampling points: Mintavételek száma
• Channel: Csatornák száma
• Trigger Register Setting: Trigger jelre történő mintavételezés esetén itt állíthatjuk be, hogy 

melyik regiszter adja a trigger jelet
• SCRO: „Multiple page” kiválasztása esetén az „SCRO” mezőben beállított regiszterrel 

tudunk lapozni az oldalak között
• Pause-Clear(ClearAddr=ResetAdrr+1): Mintavételezést megállíthatjuk, törölhetjük a 

görbéket
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Oscillograph → Channel

Beállíthatjuk a csatornáink Adattípusát („DataType”), minimumát („X Min.”/„Y Min”), maximumát 
(„X MAX”/„Y Max”) valamint a színeit.
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Oscillograph → Extended Attributes 

Beállíthatjuk csatornáink megjelenését.
• Number of Points: Mintavételezési pontokat módosíthatjuk. (Ha nincs kapcsolat a plc-vel a 

rendszer az alapértelmezett beállítást használja.)
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Oscillograph → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Note Book

A „Note Book” eszközzel szöveget vihetünk be a képernyőről, illetve írhatunk ki a képernyőre.
Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző 
területére. Dupla kattintással elérjük az elem beállításait.

• High byte and low byte swaps: Felcseréli az MSB és az LSB pozícióját egy bájton belül
• Read Address Same As Write Address: A jelölőnégyzet üresen hagyásával különböző 

területet olvashatunk és írhatunk, bejelölésével közös mezőn olvashatunk, írhatunk.
• Addr. Type: Az kiírni kívánt regiszter típusa
• Address: A regiszter címe
• Code Type: BIN, BCD
• Word Length: A szó hossza
• Use the index register: Indexelhetjük regiszterünket
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn)Note 

Book
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Note Book → Notepad 

• Total Lines: Összes sor száma
• Display Lines: Kijelzett sorok száma
• The Word Register Number of Per Line: Egy sorba lévő word-k száma

(Minden word kettő ASCII karaktert vagy egy Kínai karaktert tud megjeleníteni)
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Note Book → Keyboard Setting 

• Keyboard Setting: Billentyűzet beállítása
• Public Windows Keyboard: Alapértelmezett Windows billentyűzet

Specified Keyboard: Speciális billentyűzet (NUM Keyboard, ASCII Keyboard, HEX 
Keyboard)

• Keyboard Pop-up Position (HMI Screen Position): Billentyűzet helyzete a kijelzőn
• Not Use Pop-up Keyboard (Input by Map Key or External Keyboard): Ne használjon 

felugró bilentyűzetet (bevitel külön gombbal vagy külső billentyűzettel történik)
• Use Input Order: A számbevitelt folyamatossá tehetjük. A billentyűzet csak akkor tűnik el 

ha a piros X-el kikapcsoljuk
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Note Book → Graphics 

Itt kiválaszthatjuk, hogy a gombunk milyen külalakkal rendelkezzen.
Az „Import Graphics” gombra kattintva válogathatunk a program által felkínált különböző stílusú 
gombok közül. Lehetőségünk van egyedi gombok készítésére is az eszköztárban a „New Graphic” 
ikonra kattintva. 
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Note Book → Control Setting 

Itt állíthatjuk be, hogy az elemünk milyen feltételek mellett legyenek működtethető illetve, milyen 
feltételek mellett módosíthassuk ezt az elemet.

• Always Valid: Mindig módosítható az elem.
• Always Invalid: Sose legyen módosítható az elem. (Itt egy almenübe beállíthatjuk, hogy a 

nem használható elem látható legyen-e.)
• Conditional Enabling: Beállíthatjuk, hogy milyen biztonsági szinten lehessen módosítani 

az elemet, illetve egy másik regiszter tartalmától is függővé tehetjük az elem módosítását.
• Security Level: Biztonsági szint
• Permission Control: Hozzáférés vezérlés
• Register Control: Regiszter vezérelt hozzáférés
• Bit Control: Bit állapotától függő hozzáférés
• Word Control: Word típusú regiszter tartalmától függő hozzáférés
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Note Book → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Multiple State Neon Lamp

A „Multiple State Neon Lamp” eszközzel regiszterek állapotát jeleníthetjük meg. A 
megjelenítés a különböző állapotokhoz rendelhető futó szöveggel is történhet.
Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző 
területére. Dupla kattintással elérjük az elem beállításait.

• Addr. Type: A regiszter típusa
• Address: A regiszter címe
• Code Type: BIN, BCD
• Word Length: A szó hossza
• Use the index register: Indexelhetjük regiszterünket
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn)
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Multiple State Neon Lamp → Neon Lamp 

• Moving Type: Mozgás típusa
From right to left Jobbról balra
From left to right Balról jobbra
From top to bottom Fentről le
From bottom to top Lentről fel

• Step: Lépésenkénti pixelek száma
• Speed: Mozgás sebessége
• State Num.: Állapotok száma
• Data Mapping: Állapotok száma és a hozzájuk tartozó állapotok
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Multiple State Neon Lamp → Tag 

Ebben a menüben állíthatjuk be az aktuális elem feliratait.
A „Use Tag” jelölőnégyzetét kipipálva beállíthatjuk a különböző állapotokban megjelenítendő 
feliratokat, azok méretét, színét, stílusát.
Ha különböző nyelveket szeretnénk használni, akkor azt is beállíthatjuk, ha már elkészítettük a 
„Text Library” menüben a szükséges feliratokat.
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Multiple State Neon Lamp → Graphics 

Itt kiválaszthatjuk, hogy a gombunk milyen külalakkal rendelkezzen.
Az „Import Graphics” gombra kattintva válogathatunk a program által felkínált különböző stílusú 
gombok közül. Lehetőségünk van egyedi gombok készítésére is az eszköztárban a „New Graphic” 
ikonra kattintva. 
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Multiple State Neon Lamp → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve azt, hogy milyen feltételek mellett legyen látható az 
elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Bit State Neon Lamp
 

A „Bit State Neon Lamp” eszközzel regiszterek állapotát jeleníthetjük meg. A 
megjelenítés a különböző állapotokhoz rendelhető futó szöveggel is történhet.

Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző 
területére. Dupla kattintással elérjük az elem beállításait.

• Addr. Type: A bit típusa
• Address: A regiszter címe
• Code Type: BIN, BCD
• Word Length: A szó hossza
• Use the index register: Indexelhetjük regiszterünket
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn)
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Bit State Neon Lamp → Bit Neon Lamp 

• Moving Type: Mozgás típusa
From right to left Jobbról balra
From left to right Balról jobbra
From top to bottom Fentről le
From bottom to top Lentről fel

• Step: Lépésenkénti pixelek száma
• Speed: Mozgás sebessége
• State Num.: Állapotok száma
• Data Mapping: Állapotok száma és a hozzájuk tartozó állapotok
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Bit State Neon Lamp → Tag 

Ebben a menüben állíthatjuk be az aktuális elem feliratait.
A „Use Tag” jelölőnégyzetét kipipálva beállíthatjuk a különböző állapotokban megjelenítendő 
feliratokat, azok méretét, színét, stílusát.
Ha különböző nyelveket szeretnénk használni, akkor azt is beállíthatjuk, ha már elkészítettük a 
„Text Library” menüben a szükséges feliratokat.
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Bit State Neon Lamp → Graphics 

Itt kiválaszthatjuk, hogy a gombunk milyen külalakkal rendelkezzen.
Az „Import Graphics” gombra kattintva válogathatunk a program által felkínált különböző stílusú 
gombok közül. Lehetőségünk van egyedi gombok készítésére is az eszköztárban a „New Graphic” 
ikonra kattintva. 
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Bit State Neon Lamp → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Grid

A „Grid” eszközt sor, oszlop vagy cella kijelölésére használhatjuk. Ha a cella kijelölést 
választjuk a sor számát a kijelölt regiszter mutatja az oszlop számát a kijelölt 
regiszter+1 mutatja.
Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk 

a kijelző területére. Dupla kattintással elérjük az elem beállításait.

• Addr. Type: A bit típusa
• Address: A regiszter címe
• Code Type: BIN, BCD
• Word Length: A szó hossza
• Use the index register: Indexelhetjük regiszterünket
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn)
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Grid → Table 

• Type: Kijelölés típusa
Select by row Sor kijelölés
Select by col Oszlop kijelölés
Select by cell Cella kijelölés

• Row: Sorok száma
• Column: Oszlopok száma
• Select color: Kijelölés színe
• Background: Color: Háttér színe
• Border Color: Elválasztó vonal színe
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Grid → Control Setting 

Itt beállíthatjuk, hogy az elemünk milyen feltételek mellett legyenek működtethető illetve, milyen 
feltételek mellett módosíthassuk ezt az elemet.

• Always Valid: Mindig módosítható az elem.
• Always Invalid: Sose legyen módosítható az elem. (Itt egy almenübe beállíthatjuk, hogy a 

nem használható elem látható legyen-e.)
• Conditional Enabling: Beállíthatjuk, hogy milyen biztonsági szinten lehessen módosítani 

az elemet, illetve egy másik regiszter tartalmától is függővé tehetjük az elem módosítását.
• Security Level: Biztonsági szint
• Permission Control: Hozzáférés vezérlés
• Register Control: Regiszter vezérelt hozzáférés
• Bit Control: Bit állapotától függő hozzáférés
• Word Control: Word típusú regiszter tartalmától függő hozzáférés
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Grid → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Historical Data Display

 A „Historical Data Display” eszközzel folyamatos adatmentésre van lehetőség, a 
belső (RW) vagy külső (ERW) memóriába.
Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és 

behúzzuk a kijelző területére. Dupla kattintással elérjük az elem beállításait.

Addr. Type: A bit típusa
Address: A regiszter címe
Code Type: BIN, BCD
Word Length: A szó hossza
Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn)
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Historical Data Display → Display Properties 

Channel: Csatornák száma
Sequence No.: Sorszámozás
Ascending Order: Növekvő sorrend
Date: Dátum
Dae Separator: Dátum elválasztó
Time: Idő kijelzése
Background Color: Háttérszín
Title Bar Color: Címsor színe
Border Color: Keret színe
Width: Keret vastagsága
Separator Color: Elválasztó vonal színe
Style: Vonal stílusa
Width: Vonal vastagsága
Horizontal Line: Vízszintes vonalak
Vertical Line: Függőleges vonalak
Row Space: Sorköz

Column Space: Oszlopköz
Historical Data Query: Adatok kimentése
Addr. Type: A bit típusa
Address: A regiszter címe
Code Type: BIN, BCD
Query by File Order: Fájl hozzárendelése a 
lekérdezéshez
Query by Date: Dátum hozzárendelése a 
lekérdezéshez
Variable Cycle: Változtatható ciklusidő 
(Kommunikációs hiba esetén az alapértelmezett 
beállítás lép érvénybe)
Addr. Type: A bit típusa
Address: A regiszter címe
Code Type: BIN, BCD
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Historical Data Display → Background Attribute 

• Sam.Type: Mintavételezés típusa („Once”-egyszer, „Continous”-folyamatos)
• Sampling Methods: Mintavételezés módja

Time sampling Idő alapú mintavételezés
OFF->ON trigger sampling OFF->ON állapotváltásra vezérelt
ON->OFF trigger sampling ON->OFF állapotváltásra vezérelt
OFF<->ON trigger sampling OFF<->ON állapotváltásra vezérelt
OFF->ON reset trigger 
sampling

OFF->ON reset-re vezérelt

OFF<-ON reset trigger 
sampling

OFF<-ON reset-re vezérelt

• Cycle: Mintavételezés ciklusidejéne
• Sampling points: Mintavételek száma
• Trigger Register Setting: Trigger jelre történő mintavételezés esetén itt állíthatjuk 

 be, hogy melyik regiszter adja a trigger jelet
• Addr. Type: A bit típusa
• Address: A regiszter címe
• Code Type: BIN, BCD

• Pause-Clear(ClearAddr=ResetAdrr+1): Mintavételezést megállíthatjuk, törölhetjük 
   a görbéket

• Addr. Type: A bit típusa
• Address: A regiszter címe
• Code Type: BIN, BCD
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Historical Data Display → Channel Properties 

• Display: Adat kijelzése
• No.: Sorszám
• Data Type: Adattípus
• Min Limit: Minimum limit
• Max Limit: Maximum limit
• Integer: Egész szám
• Decimal: Tizedes jegy
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Historical Data Display → Save Historical Data 

• Save to Recipe Data Field: Nemfelejtő területre mentjük
• Save as CSV: CSV formátumban menthetjük adatainkat

• External Device: USB/SD kártya
• Subdirectory: Annak a mappának a neve ahova mentjük az adatokat
• Trigger para: Triggerelhetjük, hogy milyen feltétel esetén végezze a kimentést

• Save to External Device: Közvetlenül menthetünk küldő adathordozóra
• Storage Devices: USB/SD kártya
• Subdirectory: Annak a mappának a neve ahova mentjük az adatokat
• Storage Type: Daily File- naponta kerül külön fájlba a mért adat

Single File- minden adat külön fájlba kerül
• Bulk Storage: Mentés területének mérete
• Max Storage: Mentés hány napig tartson (ha itt nulla van, akkor a tárhely 

   határozza meg)
• Variable Subdirectory: Változtathatjuk, hogy melyik nevű mappába mentsük adatainkat
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Historical Data Display → Background Print 

• Use Background Data Print: Háttéradatok nyomtatás engedélyezése
• Print Type: Nyomtatás típusa
• Real-time: Minden mintavételezett adat nyomtatása valós időben
• Batch: Vezérelt nyomtatás, ha a mintavételezett pontok száma eléri a beállított 

mintavételezési számot
• Point: „Batch” vezérlés esetén a mintavételezési pontok száma
• Trig: Regiszterrel vezérelt nyomtatás
• Net Print: Hálózati nyomtatás engedélyezése
• Print Content: Nyomtatási tartalom
• Print Serial Number: Sorozatszám nyomtatása a mintavételezési pontoknál
• Print Table Header: Táblázat fejlécének nyomtatása a mintavételezési pontokkal

• Print Grid: Táblázatban szereplő rács nyomtatása
• Print Date: Dátum nyomtatása a mintavételezési pontokhoz. Dátum beállítása
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• Print Time: Időpont nyomtatása a mintavételezési pontokhoz
• Grid: Vonalak stílusának beállítása
• Trigger Print Address: Regiszterrel vezérelt nyomtatás

• Addr. Type: A bit típusa
• Address: A regiszter címe
• Code Type: BIN, BCD

Historical Data Display → Title Bar Properties

Táblázat beállítása.
• Name: Név
• Title Display Text: Megjelenítendő szöveg
• The column font: Oszlop szövegének stílusa
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Historical Data Display → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)

173.



Operation Log

Az „Operation Log” eszközzel műveleteket rögzíthetünk táblázatos formában. 
Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző 
területére. Dupla kattintással elérjük az elem beállításait.

• Addr. Type: A regiszter típusa
• Address: A regiszter címe
• Code Type: BIN, BCD
• Use the index register: Indexelhetjük regiszterünket
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn)
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Operation Log → Table Display Component 

• Table Display: Táblázat elemei
• Time:Idő formátum
• Date: Dátum formátum
• Date Separator: dátum elválasztó
• Sequence No.: Sorszámozás
• Ascending Order: Növekvő sorrend
• User Name: Felhasználó neve

• Historical Logs Query: Adatok rögzítése
• Query by File Order: Fájl hozzárendelése a lekérdezéshez
• Query by Date: Dátum hozzárendelése a lekérdezéshez

• Background Setting: Háttér beállítása
• Background color: Háttér színe
• Title Bar Background Color: Fejléc hátterének színe
• Border Color: Keret színe
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• Border Width: Keret vastagsága
• Separator Setting: Elválasztó beállítása

• Separator Color: Elválasztó vonal színe
• Style: Vonal stílusa
• Width: Vonal vastagsága
• Horizontal Line: Vízszintes vonalak
• Vertical Line: Függőleges vonalak
• Row Space: Sorköz
• Column Space: Oszlopköz

• Title Bar Setting: Táblázat beállítása
• Name: Név
• Title Display Text: Megjelenítendő szöveg
• The column font: Oszlop szövegének stílusa
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Operation Log → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Camera

A „Camera” eszközzel az USB-re csatlakoztatott kamera képét tudja megjeleníteni.
Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző 
területére. Dupla kattintással elérjük az elem beállításait.

• Addr. Type: A regiszter típusa
• Address: A regiszter címe
• Code Type: BIN, BCD
• Use the index register: Indexelhetjük regiszterünket
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn).

(LW0=0 kamera nem üzemel, LW0=1 kamera üzemel, LW0=2 2. kamera üzemel)
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Camera → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)

179.



Scale

A „Scale” eszközzel különböző stílusú skálákat valósíthatunk meg. Az elemet úgy tudjuk a 
projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző területére. Dupla 
kattintással elérjük az elem beállításait.

• Style: Stílus
Vertical Függőleges
Horizontal Vízszintes
Arc Körív
Circularity Kör

• Equal Division: Osztások száma
• Line Length: Vonal hossza
• Start Angle: Kezdő szög
• End Angle: Vég szög
• Line Color: Vonal színe
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Scale → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Function Key

A „Function Key” eszközzel olyan elemet hozhatunk létre, amely egy adott funkcióra használható.
Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző 
területére. Dupla kattintással elérjük az elem beállításait.

• Switch Window: Képernyő váltás
• Change window: Képernyő csere
• Goto Prev: Visszaugrás az előző aktív ablakra
• Change common window: Alapértelmezett ablak cseréje
• Change fast selection window: Gyors választó ablak cseréje
• Popup window: Felugró ablak
• Close window: Ablak bezárása
• Popup window title bar: Felugró ablak címsorára kattintva majd egy másik pontra 

kattintva áthelyezhető az ablak
• Minimize: A felugró ablak bezárása. (Bezárás után egy kis ikon jelenik meg a        

„Task Bar”-on, ha rákattintunk visszajön az ablakunk.)
• Keyboard Function: Billentyűzet funkciók
• Execute Macro: Macro kód végrehajtása
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• Map Keyboard: Funkcióbillentyűk létrehozása
• Clear Event: Esemény törlése
• Save Screenshot to the Extended Memory: Képernyőkép mentése bővítő 

memóriába
• Import/Export: Fájl vagy projekt importálása a HMI-re vagy a HMI-ről
• Message Board: Üzenőfal engedélyezése
• Tool: Eszközök

• Pen: Toll
• Erase: Törlés
• Clear Block: Terület törlése

• Pen Color: Toll színe
• Pen Width: Toll vastagsága
• Clear: Törlés
• Print: Nyomtatás funkció engedélyezése
• Printer Color: Nyomtatás színe

• Monochrome: Egyszínű nyomtatás
• Color: Színes nyomtatás
• Net Printing: Hálózati nyomtatás

• Print Page: Nyomtatási oldal
• Current page: Aktuális oldal
• Change Paper To Print: A nyomtató egy üres oldalt nyomtat majd a  következő 

lapra nyomtatja az adatokat
• Horizontal Print: Álló lapra nyomtatás
• Vertical Print: Fekvő lapra nyomtatás
• Automaticlally Take The Paper: Automatikusan papírt vételez a nyomtató a  

nyomtatásnál
• Print Text: Nyomtatási szöveg

• Print Text: Szöveg nyomtatás
• Print Meter: „Meter” elem nyomtatása
• Print Trend Graph: „Trend Graph” elem nyomtatása
• Print All Bitmap: Minden „Bitmap” elem nyomtatása
• Print All The Vector Map: Minden „Vector Graph” elem nyomtatása
• Print Background Colors: Háttér nyomtatása
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Function Key → Tag 

Ebben a menüben állíthatjuk be az aktuális elem feliratait.
A „Use Tag” jelölőnégyzetét kipipálva beállíthatjuk a különböző állapotokban megjelenítendő 
feliratokat, azok méretét, színét, stílusát.
Ha különböző nyelveket szeretnénk használni, akkor azt is beállíthatjuk, ha már elkészítettük a 
„Text Library” menüben a szükséges feliratokat.
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Function Key → Graphics 

Itt kiválaszthatjuk, hogy a gombunk milyen külalakkal rendelkezzen.
Az „Import Graphics” gombra kattintva válogathatunk a program által felkínált különböző stílusú 
gombok közül. Lehetőségünk van egyedi gombok készítésére is az eszköztárban a „New Graphic” 
ikonra kattintva. 
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Function Key → Control Setting 

Itt beállíthatjuk, hogy az elemünk milyen feltételek mellett legyenek működtethető illetve, milyen 
feltételek mellett módosíthassuk ezt az elemet.

• Always Valid: Mindig módosítható az elem.
• Always Invalid: Sose legyen módosítható az elem. (Itt egy almenübe beállíthatjuk, hogy a 

nem használható elem látható legyen-e.)
• Conditional Enabling: Beállíthatjuk, hogy milyen biztonsági szinten lehessen módosítani 

az elemet, illetve egy másik regiszter tartalmától is függővé tehetjük az elem módosítását.
• Security Level: Biztonsági szint
• Permission Control: Hozzáférés vezérlés
• Register Control: Regiszter vezérelt hozzáférés
• Bit Control: Bit állapotától függő hozzáférés
• Word Control: Word típusú regiszter tartalmától függő hozzáférés
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Function Key → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Alarm Bar

Az „Alarm Bar” eszközzel az „Alarm Information Logon” menüben megadott 
hibajelenségeket jeleníthetjük meg. Az elemet úgy tudjuk a projekthez hozzáadni, hogy 
az ikonjára kattintunk és behúzzuk a kijelző területére. Dupla kattintással elérjük az 
elem beállításait.

 

• Moving Step: Pixelek száma mozgás közben 
• Moving Rate: Pixelek ugrása x100ms-ban
• Display TypeRange: „Alarm Information Logon” menüben megadott hibajelzések közül 

kiválaszthatjuk a „Type” alapján, hogy melyiket hajtsa végre.
• Description: Itt adhatunk leírást a gombunkhoz (ez nem jelenik meg a kijelzőn). 

188.



Alarm Bar → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve azt, hogy milyen feltételek mellett legyen látható az 
elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Timer

A „Timer” eszközzel időzített feladat végrehajtást valósíthatunk meg. Az elemet úgy tudjuk a 
projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző területére. Dupla 
kattintással elérjük az elem beállításait.

• Trigger Mode: Időzítés módja
All time Folyamatos
Initial frame Az elemet tartalmazó ablak aktivizálásakor
Close frame Az elemet tartalmazó ablak bezárásakor
By Reg-Address Regiszter vezérléssel

• Execution Cycle: Ciklusidő
• Response Mode: A végrehajtás módja

Inmediate Azonnal
Delay Késleltetve

• Trigger State: Regiszter vezérlés állapota
• Repeat count: Ismétlések száma
• Trigger Address: Regiszter vezérelt időzítésnél a regiszter adatai

• Addr. Type: A regiszter típusa.
• Address: A regiszter címe.
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Timer → Timer function

• Execute Macro: Macro kód végrehajtása
• Data Transmission: Adat küldése
• Data Type: Adattípus
• Data Length: adat hossza
• Source Address: Forrás címe

• Addr. Type: A regiszter típusa.
• Address: A regiszter címe.
• Code Type: BIN, BCD

• Destination Address: Célterület címe
• Addr. Type: A regiszter típusa.
• Address: A regiszter címe.
• Code Type: BIN, BCD

• State Setting: Állapotot állíthatunk be
• Mode: Módok

Set Value Beállítandó érték
Periodical Toggle Ismétlődő váltás

• Data Type: Adattípus
• Value: Érték
• Addr. Type: A regiszter típusa.
• Address: A regiszter címe.
• Code Type: BIN, BCD
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Timer →  Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)

Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 
Setting” leírásban lévőnek megfelelő.)
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Bitmap

A „Bitmap” eszközzel statikusan jeleníthetünk meg képeket, háttereket. Az elemet úgy tudjuk a 
projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző területére. Dupla 
kattintással elérjük az elem beállításait.

• Use Original Size: Eredeti méret használata
• Import Graphics: Grafikák importálása
• Save to System Library: Elmenthetjük a rendszer mappájába
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Bitmap → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Vector Graph

A „Vector Graph” eszköz hasonló, mint a „Bitmap”, csak itt vektorgrafikákat tudunk megjeleníteni. 
Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző 
területére. Dupla kattintással elérjük az elem beállítását

• Import Graphics: Grafikák importálása
• Save to System Library: Elmenthetjük a rendszer mappájába

195.



Vector Graph → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve azt, hogy milyen feltételek mellett legyen látható az 
elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Note Pad

A „Note Pad” eszközzel egy olyan területet hozhatunk létre, melyre rajzolhatunk, írhatunk szabad 
kézzel. Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a 
kijelző területére. Dupla kattintással elérjük az elem beállításait. 

• Frame Width: Keret vastagsága
• Frame Color: Keret színe
• Fill Background: Háttér kitöltő színe
• Foreground Color: Előtér színe
• Background Color: Háttér színe
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Note Pad → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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File List

A „File List” eszközzel fájlműveleteket hajthatunk létre. Például másolhatunk USB1-ről SD-re. Az 
elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző 
területére. Dupla kattintással elérjük az elem beállításait.

Size: Betűméret
Color: Betűszín

Ennek az eszköznek a teljes működéséhez szükségünk van az LW9366-os regiszterre. 
LW9366=1 Másolás (Copy)
LW9366=2 Kivágás (Cut)
LW9366=3 Beillesztés (Paste)
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File List → Graphics 

Itt kiválaszthatjuk, hogy a gombunk milyen külalakkal rendelkezzen.
Az „Import Graphics” gombra kattintva válogathatunk a program által felkínált különböző stílusú 
gombok közül. Lehetőségünk van egyedi gombok készítésére is az eszköztárban a „New Graphic” 
ikonra kattintva. 
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File List → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Data transmission

A „Data Transmission” eszközzel adatot mozgathatunk. Az elemet úgy tudjuk a projekthez 
hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző területére. Dupla kattintással elérjük 
az elem beállításait.

• Data Type: Bit, Word
• Data Length: Adathossz (Bit)
• Key: Kiegészítő billentyűzet funkció gombjai hozzárendelhetőek
• Sources Address: Forrás cím
• Addr. Type: A regiszter típusa.
• Address: A regiszter címe.
• Code Type: BIN, BCD
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• Destinaiton Address: Célterület címe
• Addr. Type: A regiszter típusa.
• Address: A regiszter címe.
• Code Type: BIN, BCD
• Variable Parameters: Változtatható paraméterek
• Source: Forrás
• Destination: Célterület
• Data Length: Adathossz
• Addr. Type: A regiszter típusa.
• Address: A regiszter címe.
• Code Type: BIN, BCD

Data transmission → Trigger Address 

• Use Trigger Address: Vezérlő cím használata
• Address Type: Adattípus
• Address: Cím
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Data transmission → Tag 

Ebben a menüben állíthatjuk be az aktuális elem feliratait.
A „Use Tag” jelölőnégyzetét kipipálva beállíthatjuk a különböző állapotokban megjelenítendő 
feliratokat, azok méretét, színét, stílusát.
Ha különböző nyelveket szeretnénk használni, akkor azt is beállíthatjuk, ha már elkészítettük a 
„Text Library” menüben a szükséges feliratokat.
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Data transmission → Graphics 

Itt kiválaszthatjuk, hogy a gombunk milyen külalakkal rendelkezzen.
Az „Import Graphics” gombra kattintva válogathatunk a program által felkínált különböző stílusú 
gombok közül. Lehetőségünk van egyedi gombok készítésére is az eszköztárban a „New Graphic” 
ikonra kattintva. 
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Data transmission → Control Setting 

Itt beállíthatjuk, hogy az elemünk milyen feltételek mellett legyenek működtethető illetve, milyen 
feltételek mellett módosíthassuk ezt az elemet.

• Always Valid: Mindig módosítható az elem.
• Always Invalid: Sose legyen módosítható az elem. (Itt egy almenübe beállíthatjuk, hogy a 

nem használható elem látható legyen-e.)
• Conditional Enabling: Beállíthatjuk, hogy milyen biztonsági szinten lehessen módosítani 

az elemet, illetve egy másik regiszter tartalmától is függővé tehetjük az elem módosítását.
• Security Level: Biztonsági szint
• Permission Control: Hozzáférés vezérlés
• Register Control: Regiszter vezérelt hozzáférés
• Bit Control: Bit állapotától függő hozzáférés
• Word Control: Word típusú regiszter tartalmától függő hozzáférés
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Data transmission → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Date/Time

A „Date/Time” eszközzel az időt és a dátumot jelezhetjük ki. Az elemet úgy tudjuk a projekthez 
hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző területére. Dupla kattintással elérjük 
az elem beállításait.

• Display Date: Dátum kijelzése
• Data Separator: Dátum elválasztó
• Year 4-digit Display: 4 számjegyes év kijelzés
• Zero Suppress for Month and Day: Nullák elrejtése a hónapoknál és a napoknál.
• Display Week: Hetek kijelzése
• Display Time: Idő kijelzése
• 12-hour System (AM/PM): 12 órás kijelzés
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Date/Time → Graphics 

Itt kiválaszthatjuk, hogy a gombunk milyen külalakkal rendelkezzen.
Az „Import Graphics” gombra kattintva válogathatunk a program által felkínált különböző stílusú 
gombok közül. Lehetőségünk van egyedi gombok készítésére is az eszköztárban a „New Graphic” 
ikonra kattintva. 
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Date/Time → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Dynamic Graph

A „Dynamic Graph” eszközzel az elem méreteit és helyzetét határozhatjuk meg. Az elemet úgy 
tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző területére. Dupla 
kattintással elérjük az elem beállításait.

• Graphic Type: Megjelenítés típusa
Rect: Szögletes
Ellipse: Ellipszis
Line: Vonal

• Line Color: Keret/Vonal színe
• Line Width: Keret/Vonal vastagsága
• Line Style: Keret/Vonal stílusa
• Background Fill Color: Háttér színe
• Foreground Fill Color: Előtér színe
• Pattern Fill: Kitöltő motívum
• Fountain Fill: Kitöltő stílus
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Dynamic Graph → Dynamic Graph Position

• The Upper-left Corner of Variable: X,Y pozíció módosítható.
• Addr. Type: A regiszter típusa.
• Address: A regiszter címe.
• Code Type: BIN, BCD

• The Width/Height of Variable: Az elem szélessége és magassága módosítható
• Addr. Type: A regiszter típusa.
• Address: A regiszter címe.
• Code Type: BIN, BCD
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Dynamic Graph → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)

• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 
Setting” leírásban lévőnek megfelelő.)
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User Info Display

A „User Info Display” eszközzel a felhasználói beállítások követhetőek nyomon. Előzetes 
beállításként szükséges a „User Permission Setting” menüben (a főmenüben a kijelző ikonjára 
kattintva érjük el ezt a menüt). Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára 
kattintunk és behúzzuk a kijelző területére. Dupla kattintással elérjük az elem beállításait.

• Sequence No.: Sorszám kijelzés
• Separator Color: Elválasztó szín
• Style: Elválasztó stílusa
• Width: Elválasztó vastagsága
• Horizontal Line: Vízszintes vonal
• Vertical Line: Függőleges vonal
• Row Space: Sor vastagsága
• Column Space: Oszlop szélessége
• Background Color: Háttér színe
• Title Bar Background Color: Címsor háttér színe
• Border Color:  Keret színe
• Border Width: Keret vastagsága
• Title Bar Setting: Címsor beállítása
• Title Display Text: Cím szövege
• The column font: Oszlop betűtípusa
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User Info Display → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve, hogy milyen feltételek mellett legyen látható az elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Combination Operations

A „Combination Operations” eszközzel a „Bit State Setting” és a „Multiple State Setting” elemeket 
tudjuk kombinálni. Az elemet úgy tudjuk a projekthez hozzáadni, hogy az ikonjára kattintunk és 
behúzzuk a kijelző területére. Dupla kattintással elérjük az elem beállításait. A „Component List” 
mezőbe kattintva az egér jobb gombjával gombokat importálhatunk.

• Insert before: Beillesztés az elem elé
• Insert behind: Beillesztés az elem mögé
• Move Up: Mozgatás felfelé
• Move Down: Mozgatás lefelé
• Delete: Törlés
• Bit State Setting: Bit állapotát kapcsolhatjuk
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• Multiple State Setting: Adatot írhatunk a PLC regiszterébe
• Addr. Type: A regiszter típusa.
• Address: A regiszter címe.
• Code Type: BIN, BCD
• Type: Típus
• Multiple State Setting esetén:

Set Constans Konstans beállítása
Add Value Érték hozzáadás
Sub Value Érték kivonás

• Addend: Hozzáadandó érték
• Upper: Felső határ
• Bit State Setting elem esetén:

On Be 
Off Ki
Toggle Váltó kapcsoló
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Combination Operations → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve azt, hogy milyen feltételek mellett legyen látható az 
elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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Pipeline

A „Pipleline” eszközzel csővezetéket tudunk megjeleníteni. Az elemet úgy tudjuk a projekthez 
hozzáadni, hogy az ikonjára kattintunk és behúzzuk a kijelző területére. Dupla kattintással elérjük 
az elem beállításait.

• Radius: Sugár
• Thickness: Vastagság
• Body Color: Csővezeték színe
• Border Color: Csővezeték széleinek színe
• Body Color Changeable: Változtatható csővezeték színek
• Default Color: Alapértelmezett szín
• Flicker: Bittel vezérelhető villogás
• Use Flow Effect: Folyásirány jelzése
• Symbol: Folyásirányt jelző szimbólum

219.



• Copy Symbol to All Pipe: Szimbólum használata minden csővezeték szakaszon
• Symbol Color: Szimbólum színe
• Copy Color to All Pipe: Csővezeték színének másolása minden csővezeték szakaszra
• Display Length(%): Folyásirány jelölésének mérete %-ban
• Copy Length ti all Pipe: Folyásirány jelölésének méretét az összes csővezetékszakaszra 

másoljuk
• Use Flowinfo to All Pipe: Az egész csővezetéken alkalmazza a folyásirány jelölést
• Not use flowinfo to All Pipeline: Ne használja az egész csővezeték szakaszon a folyásirány 

jelölést
• Controll Address: Vezérlő regiszter címe

• Addr. Type: A regiszter típusa.
• Address: A regiszter címe.
• Code Type: BIN, BCD
• Word Lenth: Word hossza
• Bit 0 is on: Csővezeték színe 2
• Bit 1 is on: Csővezeték színe 3
• Bit 2 is on: Csővezeték villog
• Bit 3 is on: Folyásirány mutatása
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Pipleline → Pipe Info

• Pipe List: Csővezeték szakaszok listája
• Type: Csővezeték típusa

• HLINE: Vízszintes vezeték
• VLINE: Függőleges vezeték
• BendNode: Hajlítás/Csomópont

• Pipe Setting: Csővezeték beállítása
• Flow Effect: Folyásirány jelölése
• Symbol: Szimbólum
• Color: Csővezeték színe
• Display Length: Folyásirány jelzésének hossza
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Pipleline → Display Setting 

Beállíthatjuk az elemünk pozícióját, illetve azt, hogy milyen feltételek mellett legyen látható az 
elem.

• Always Display:Mindig látható.
• Never Display (Touching is invalid): Nem látható. (Ilyenkor nem is módosítható)
• Conditional Display: Feltételes kijelzés. (Az almenüben lévő beállítások a „Control 

Setting” leírásban lévőnek megfelelő.)
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